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GigaVUE-FM Installation, Migration, and
Upgrade

This guide describes how to install, migrate, and upgrade the GigaVUE—FM® Fabric Manager
(GigaVUE-FM).

Topics:

Installation
* Install GigaVUE-FM on VMware ESXi
« Install GigaVUE-FM on MS Hyper-V
* Install GigaVUE-FM on KVM
« Setting the Admin Password for the GigaVUE-FM Shell

Migration
» Migrate GigaVUE-FM

» Related Commands

Upgrade
» Upgrade GigaVUE-FM

GigaVUE-FM Installation, Migration, and Upgrade
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Install GigaVUE-FM on VMware ESXi

This section describes how to install GigaVUE-FM on VMware hypervisor, ESXi. It consists of the
following main sections:

« Before You Install describes the minimum hardware and computing requirements.

* Install New GigaVUE-FM on VMware ESXi describes the steps to install and deploy GigaVUE-
FM on VMware ESXi hypervisor.

Before You Install

This section describes the hardware and virtual computing requirements for GigaVUE-FM. Ensure that
the time on the VMware ESXi host is set correctly to ensure accuracy of the trending data that is
captured.

Prerequisites for GigaVUE-FM

Before Installing GigaVUE-FM, ensure that VMware vSphere Standard, Enterprise, or Enterprise Plus is
installed on hardware that meets minimum requirements. The following VMware vSphere versions
are supported. Note the minimum version requirements under Hardware Requirements.

VMware ESXi and NSX-V Hardware Requirements

The following table describes the hardware requirements on which VMware ESXi runs GigaVUE-FM.

Table 1: Hardware Requirements for VMware Hypervisor

Hardware Requirements

VMware Hypervisor vSphere ESXi: v5.5 and above.

CPU One or more 64-bit x86 CPUs with virtualization assist
(Intel-VT or AMD-V) enabled.

Note: To run GigaVUE-FM, hardware support for
virtualization must be enabled on the VMware ESXi host.
Make sure that the BIOS option for virtualization support
is not disabled. For more information, see your BIOS
documentation

Install GigaVUE-FM on VMware ESXi 7
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Hardware Requirements

RAM At least 16GB

Disk Space At least 84GB shared (FC, iSCSI, NFS, or FCoE) or locally
attached storage (PATA, SATA, SCSI)

NoOTE: Increase the disk space depending on the
configuration load requirements for the given GigaVUE-
FM instance.

Network At least one 1Gb NIC

The following table lists the virtual computing resources for GigaVUE-FM.

Table 2: Minimum Virtual Computing Requirements for VMware Hypervisor

Minimum Virtual Computing Requirements

Memory Minimum 16GB memory
Virtual CPU (vCPU) 2vCPU
Virtual Storage for Guest 84GB using PVSCSI (VMware Paravirtual SCSI)

« System Disk - 40GB

» Swap Disk - 4GB

+ Data Disk - 40GB

Virtual Network Interfaces One vNIC using VMXNET3 (VMware 3rd Generation Paravirtual NIC)

Supported Browsers

GigaVUE-FM has been tested on the following browsers:

Browser Version

Mozilla Firefox™ « Version 49.00

Apple® Safari® « Version 9.1 and Higher
Google® Chrome® * Version 54 and higher
Microsoft Edge » Version 38

Notes:

« Only the browsers that support TLS v1.2 can access GigaVUE-FM.
« Internet Explorer 11 (IE11) is deprecated for security reasons and is no longer supported. IE users

are strongly encouraged to switch to Microsoft Edge.

Install GigaVUE-FM on VMware ESXi 8
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Install New GigaVUE-FM on VMware ESXi

The GigaVUE-FM software package is distributed as an OVA file. The following sections describe
how to deploy a fresh installation of GigaVUE-FM on an ESXi host and perform its initial

configuration:
¢ Deploy GigaVUE-FM from an OVA File
« Initial GigaVUE-FM Configuration

Deploy GigaVUE-FM from an OVA File

Use the vSphere Client to install the GigaVUE-FM OVA file. Starting from software version 5.3, you
cannot deploy GigaVUE-FM directly from the ESXi host. You must login to the VCenter on the
vSphere client to deploy a GigaVUE-FM instance.

NoTE: The OVA file must be stored in a location that is accessible to the vSphere Client. This
location cannot be a datastore accessible to the ESXi host which will be the target of the

deployment.

NoTE: Starting in software version 5.4.01, you cannot deploy the GigaVUE-FM OVA file on
older versions of VMware ESXi. If you have an older version of ESXi, then you must upgrade
your VMware ESXi to at least version 5.5. Otherwise, GigaVUE-FM OVA deployment will fail.

The following steps are shown using the ESXi version 6.x. To deploy a GigaVUE-FM instance:

1. Log in to the VMware vCenter web interface.
2. Go to Menu > VMs and Templates.
3. Right-click the ESXi Host or data center on which you want to deploy GigaVUE-FM 5.8, and

then select Deploy OVF Template as shown in the following figure:

Install GigaVUE-FM on VMware ESXi
Install New GigaVUE-FM on VMware ESXi



GigaVUE-FM Installation and Migration Guide

vm  v5phere Client
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“‘ﬁﬂ Mew Cluster._..
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Distributed Switch L
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Y§ Deploy OVF Template...
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Edit Default WM Compatibility...

Figure 1  vSphere Client: OVF Template
The Deploy OVF Template wizard opens.

Install GigaVUE-FM on VMware ESXi
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Deploy OVF Template

1 Select an OVF template

2 Select a name and folder
3 Select a compute resource
4 Review details

5 Select storage

6 Ready to complete

Select an OVF template
Select an OVF template from remote URL or local file system

Enter a URL to download and install the OVF package from the Internet, or browse to a
location accessible from your computer, such as a local hard drive, a network share, or a
CD/DVD drive.

® URL

http | hitps:/fremoteserver-address/filetodeploy.ovf | .ova

O Local file

Browse...

CANCEL

Figure 2  vSphere Client: Find the Location of the OVA File

4. In the Select an OVF template page of the Deploy OVF Template wizard, choose one of the

following options:

a. URL—Enter the URL from where you want to download and install the OVF package.

b. Local file—Click Browse to navigate to the OVA file available on your local machine, and

then select the OVA file

5. Click the Next. The Select a name and folder page of the Deploy OVF Template wizard

appears.

Install GigaVUE-FM on VMware ESXi

Install New GigaVUE-FM on VMware
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Deploy OVF Template

v 1 Select an OVF template Select a name and folder

_ Specify 2 unigue name and target location

3 Select a compute resource

4 Review details Virtual machine name:  gigamon-gigavue-fm-5.8.00-

5 Select storage
6 Ready to complete Select a location for the virtual machine.

v [ 10.115.154.1
> [ER TME-DCA-NSXT

CANCEL BACK NEXT

Figure 3  vSphere Client: Enter Name and Location for OVA File on ESXi Server

6. Specify a unique name for the GigaVUE-FM instance, and then select a location and host to
which you want to deploy the GigaVUE-FM instance.

7. Click Next. The Select a compute resource page of the Deploy OVF Template wizard
appears.

Install GigaVUE-FM on VMware ESXi 12
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Deploy OVF Template
+ 1 Select an OVF template Select a compute resource
+ 2 Select a name and folder Select the destination compute resource for this operation
3 Select a compute resource
4 Review details W Cloud-LAB
5 Select storage > Cloud-1
6 Ready to complete > Cloud-2
> Cloud-3
Compatibility
v Compatibility checks succeeded.
CANCEL BACK NEXT

Figure 4  vSphere Client: Select a Compute Resource for the OVF Deployment

8. Select a destination compute host for the OVF deployment. The Deploy OVF Template wizard
performs a validation to ensure that the selected host has all the resources required for the
GigaVUE-FM deployment.

9. Click Next. The Review details page of the Deploy OVF Template wizard appears.

Install GigaVUE-FM on VMware ESXi 13
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Deploy OVF Template
+ 1 Select an OVF template Review details
+ 2 Select a name and folder Verify the template details.

+ 3 Select a compute resource

4 Review details

5 Select storage Publisher Mo certificate present
6 Select networks )
Product GigaVUE-FM
7 Customize template
8 Ready to complete Version 5.8.00
Vendor Gigamon Inc.
Description This is a Gigamon GigaVUE-FM Appliance. It provides a centralized view

across both physical and virtual Traffic Visibility Fabric Nodes.

Download size | 41GRE
Size on disk 6.1 GB (thin provisioned)

84.0 GB (thick provisioned)

CANCEL BACK NEXT

Figure 5  vSphere Client: Review Details

10. Verify the OVF template details, and then click Next. The Select storage page of the Deploy
OVF Template wizard appears.

Install GigaVUE-FM on VMware ESXi 14
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Deploy OVF Template
+ 1 Select an OVF template Select storage
+ 2 Select a name and folder Select the storage for the configuration and disk files

+ 3 Select a compute resource

+ 4 Review details M

5 Select storage

Select virtual disk format:  Thick Provision ~
6 Select networks
7 Customize template VM Staorage Policy: Datastore Default v
& Ready to complete Mame Capacity Provisioned
SR 924 GB 15913 GB
B 924 GB 710.04 GB
€
Compatibility

Free
84112 GB

460.91 GB

s s %

+ Compatibility checks succeeded.

CANCEL

BACK NEXT

Figure 6  vSphere Client: Select Storage

11. From the Select virtual disk format drop-down list, select Thick Provisioning as the format

for the virtual disks and provisioning.

results in GigaVUE-FM not working correctly.

NoTE: You must deploy GigaVUE-FM using Thick Provisioning. Any other choice

12. Select the datastore where the virtual machine’s files will be stored.

13. Click Next. The Select networks page of the Deploy OVF Template wizard appears.

Install GigaVUE-FM on VMware ESXi
Install New GigaVUE-FM on VMware ESXi
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Deploy OVF Template

+ 1 5Select an OVF template Select networks

+ 2 Select a name and folder Select a destination network for each source network.

+ 3 Select a compute resource

R . Source Network Destination Network
+ 4 Review details e u

+ 5 Select storage management VM Network -

6 Select networks 1items

7 Customize template

8 Ready to complete

IP Allocation Settings
IP allocation: Static - Manual

IP protocal: IPvd

CANCEL BACK NEXT

Figure 7  vSphere Client: Select Networks

14. Set network mapping by doing either of the following, depending on how your are
deploying, and then click Next:

« If you are not deploying on a standalone ESXi host, the Network Mapping displays
under Source Networks. Use the drop-down lists to assign the correct Destination
Network to the source network.

« If you are deploying GigaVUE-FM on a standalone ESXi host, the network mapping is
set automatically by assigning the destination network to the VM Network. In case of
multiple port groups, you need to manually assign the destination network to the VM
Network.

15. Click Next. The Customize template page of the Deploy OVF Template wizard appears.
16. In the System Hostname field, enter the hostname of the GigaVUE-FM instance, and then
specify 40 GB as the size of the data disk.

Install GigaVUE-FM on VMware ESXi 16
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17. Set the admin password. The admin password must be a minimum of 11 characters and a
maximum of 30 characters. The characters must include at least:

e One numerical character
« One upper case character
» One lower case character
« One special character

NoOTE: The password that you set here is applicable only to the GigaVUE-FM Shell. To
access the GigaVUE-FM UlI, the default username is admin and password is
admin123A!l. You can change the password when you first login to the GigaVUE-FM UI.

If the password does not meet the complexity requirements:
« The system does not display any error message.
+ The parameters configured above are not passed on to the GigaVUE-FM except the host
name parameter.
« The static IP addresses that were configured originally will be unavailable after GigaVUE-
FM is deployed.

18. (Optional) Complete the IP Networking configurations such as the default gateway for the
management port, IP address of the DNS server, and the domain name for this GigaVUE-FM
instance.

19. (Optional) Complete the NTP configurations such as the IP address and version of the NTP
server, and then click Next.

Install GigaVUE-FM on VMware ESXi 17
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Deploy OVF Template

1 Select an OVF template Customize template

2 Select a name and folder

Customize the deployment properties of this software solution.

3 Select a compute resource

4 Review details ‘ (@ Al properties have valid values

5 Select storage

v
v
"
v
v
v

6 Select networks

7 Customize template

& Ready to complete

- Basic Configuration

01. System Hostname

02. Size of Data Disk

03. Optional admin

password

4 settings

A Unique hostname for this instance.

GigaVUE-FM-5800

The size of the Data Disk in gigabytes.

=

40

If set, the default admin password will be set to
this value to allow password based login. The
password will be good for only a single login. You
MUST specifiy either a password or an SSH Public
Key, otherwise you will NOT be able to access

your GigaWUE-FM instance.
Password

Confirm

Password

L

CANCEL BACK NEXT

Figure 8  vSphere Client: Customize Template

Install GigaVUE-FM on VMware ESXi

NOTE: You can also choose to perform the IP Networking and NTP configurations by
running the fmctl jump-start command after you power on the GigaVUE-FM instance at
the successful completion of the OVF template deployment. For details, refer to
Perform Network Configurations

The Ready to Complete page of the Deploy OVF Template wizard appears.

18

Install New GigaVUE-FM on VMware ESXi



GigaVUE-FM Installation and Migration Guide

Deploy OVF Template

1 Select an OVF template Ready to complete

2 Select a name and folder

Click Finish to start creation.

L'

v

+ 3 Select a compute resource
v 4 Review details
v
v
v

5 Select storage Provisioning type

6 Select networks Mame

7 Customize template

& Ready to complete

Template name
Download size
Size on disk
Folder
Resource
Storage mapping
All disks
Metweork mapping
management
IP allocation settings
IP protocol

IP allocation

Deploy OVF From Remote URL
gigamon-gigavue-fm-5.8.00
gigamon-gigavue-fm-58.00

41GB

6.1GB

Workload

Cloud-2

1

Datastore: 10.210.108.7; Format: Thick Provision
1

VM Metwork

IPvV4

Static - Manual
L

CANCEL BACK FINISH

Figure 9

vSphere Client: Final Verification Before Installation

20. Verify that all of the settings are correct, and then click Finish. The Recent Tasks pane of the
vSphere Client Home page shows the progress of the deployment operation.

Recent Tasks Alarms

Task Name ~  Target ~ Status
Deploy OVF template gigamon-gigavue-fm... [l
Import OVF package Cloud-2 [ ]

Figure 10 vSphere Client: OVF Deployment Progress

~  Details
5% @
7% 9

When the operation completes, you have successfully deployed a GigaVUE-FM instance.

Important: Clear the browser cache before logging in to GigaVUE-FM.

Install GigaVUE-FM on VMware ESXi
Install New GigaVUE-FM on VMware ESXi

19




GigaVUE-FM Installation and Migration Guide

Redeploy GigaVUE-FM Instance (with VMs Already
Deployed)

If there is a need to remove an existing instance of GigaVUE-FM and reinstall it, delete all the virtual
centers configured in the Virtual > Management > Virtual Center tab prior to deleting the GigaVUE-
FM. To re-install GigaVUE-FM, refer to the Install New GigaVUE-FM on VMware ESXi or Install
GigaVUE-FM for Microsoft Hyper-V.

By deleting the virtual centers, you will lose all the GigaVUE-VM nodes and vMaps configured on
those virtual centers and they will need to be recreated.

Initial GigaVUE-FM Configuration

After you have deployed a new GigaVUE-FM instance, you can choose to perform some initial
configuration before you start using GigaVUE-FM. This procedure only needs to be performed once
for each GigaVUE-FM instance deployed.

NoTE: Use care when Shutting Down or Rebooting a GigaVUE-FM. Never directly Power-Off
the virtual machine. In VMware ESXi environment when using vSphere client, ALWAYS use
Shut Down Guest OS or Restart Guest functions from VMware. Access is available from
either the FILE menu or from the appropriate buttons on the GigaVUE-FM console. Failure to
follow these steps may lead to database corruption issues.

Use Fault Tolerance for GigaVUE-FM Deployments (VMware ESXi only)

Gigamon recommends that you enable the VMware Fault Tolerance feature for the GigaVUE-FM
virtual machine, providing redundancy in the case of a failure. Enabling the VMware Fault Tolerance
feature provides a "hot” GigaVUE-FM virtual machine instance on another ESXi host in the cluster. If
the ESXi host with the primary GigaVUE-FM instance goes down, you can take advantage of the Fault
Tolerance feature to continue GigaVUE-FM operations.

When in Fault Tolerance mode, the MAC address and the UUID for both the primary GigaVUE-FM
and the "hot” GigaVUE-FM virtual machine instance remains the same, therefore there is no need to
update the existing licenses for GigaVUE-FM or GigaVUE-VM that are installed on the primary.

Both instances of the GigaVUE-FM implement VMware vLockstep technology to keep in virtual
lockstep with each other. Any events are executed on the primary and then transmitted over a
Gigabit Ethernet network to the other instance. Both instances access a common disk and appear as a
single instance since they share the MAC address and UUID.

NoTE: Refer to the VMware Fault Tolerance documentation for deployment requirements
and instructions.

Install GigaVUE-FM on VMware ESXi 20
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Depending on the host configurations, there may be a need to shutdown GigaVUE-FM (primary) to
enable the Fault Tolerance mode.

Perform Initial Configuration

Before powering on GigaVUE-FM, you can optionally perform the following:
« Perform Network Configurations
+ Add Additional vNIC
* Increase the Memory
« Add vCPUs

Perform Network Configurations

To perform the initial configuration:
1. Log in to GigaVUE-FM using one of the following methods:

« If you have a static IP address set up for the GigaVUE-FM, log in through SSH.
« If you do not have a static IP address set up for the GigaVUE-FM, complete the following

steps:
a. Log into the VMware vCenter web interface.
b. Go to Menu > VMs and Templates.
¢. Right-click the GigaVUE-FM virtual machine, and select Open Remote Console.
d. Log in with your GigaVUE-FM Shell credentials.

2. Perform the following steps to complete the initial configuration:

a. Run the fmctl jump-start command. The Initial System Configuration screen appears as
shown in the following figure:

Install GigaVUE-FM on VMware ESXi 21
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unconf igured-gigawue—fm

yes

H._centos.pool .ntp.org 1.centos.poo
4

b. Provide a unique hostname for GigaVUE-FM. Note that the hostname may contain
letters, numbers, periods (.), and hyphens (-), but may not begin with a hyphen. No
other special characters are permitted.

c. Enter the required domain name.
d. Decide whether to use DHCP for the management interface. Choose one of the
following options:

« If you enter yes, the IPv4 Address or IPv6 Address, CIDR, Gateway, DNS Servers,
and Search Domains are dynamically set up for the management interface.

« If you enter no, you must provide the following:

i. IPv4 Address or IPv6 Address, and the respective CIDR and Gateway.
ii. Inthe DNS Servers field, provide the address of any additional name servers
required. Enter the set of IP addresses with spaces in between.
iii. In the Search Domains field, provide the required DNS domains with spaces in
between.
e. You can choose to either enable or disable NTP. In the Enable NTP field, enter one of
the following:

« Yes—Use NTP to synchronize the time between GigaVUE-FM virtual machine and the
NTP server. In the NTP Servers and NTP Version fields, enter the NTP server address
and the version number of the NTP server.

« No—you can skip the next step and directly save your configurations.

f. Select OK to save your configurations.
g. Reboot your GigaVUE-FM virtual machine.

You can now access GigaVUE-FM by opening a browser and entering its IP address (the
IP address you specified).

Install GigaVUE-FM on VMware ESXi 22
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Add Additional vNIC

Gigamon allows you to configure GigaVUE-FM with two network interfaces—ethO and eth1. The
network interface ethO can be configured to connect to a network used to manage Gigamon
devices. The other network interface eth1 can be configured to connect to a network hosting
different servers like SMTP server, Archive server, and so on.

To add an additional vNIC:

1. Right-click the GigaVUE-FM instance and select Edit Settings... Refer to Figure 11vSphere
Client: Edit Settings.

Bl [ vesass-aaa-26-40 GigaVUE-FM50-22-89
= [l =2 0 - : . :
=@ 0202057 Py Summary | Resource Allocation | Performance | Tasks &Events | Alarms | Console | Permissions | Maps | Storage Views
& close tan (5

Power L3 What is a Virtual Machine?
Guest > A virtual machine is a software computer that, like a
Snapshot L4 physical computer, runs an operating system and Virtual Machines

B Open Console applications. An operating system installed on a virfual A

@ Edit Settings. machine is called a quest operaling system.

Bl Migrate.. Because every virtual maching is an isolated computing Cluster [[Sfe
Upgrade Virtual Hardware environment, you can use virtual machines as desktop or

workstation environments, as testing environments, or to

B8 Clone. consolidate server applications

Templat 3
emplate In vCenter Server, virtual machines run on hosts or

Fault Tolerance 3 clusters. The same host can run many virtual machines.
VM Storage Profile , kl Datacenter
Add Permission... crlp vCenter Server
Alarm > Basic Tasks vSphere Client
Report Performance... [+ Power on the virtual machine
Rename 5 Edit virtual machine settings
Open in New Window:... CtrleAlts N Explore Further
Remove from Inventory
Delete from Disk =l Learn more about virtual machines

Learn how to install an operating system

Figure 11 vSphere Client: Edit Settings
2. Inthe Hardware tab, click Add.

3. Inthe Add Hardware dialog box, select Ethernet Adapter and then click Next.Refer to Figure

12vSphere Client: Selecting Ethernet Adapter.
r@AddHardware = l - (i

Device Type
[l What sort of device do you wish to add to your virtual machine?
Device Type Choose the type of device you wish to add.
Metwork connection
Ready to Complete 6 serial Port — Information

A:’ Parallel Port This device can be added to this Virtual Machine.
4 Floppy Drive

25 cD/DVD Drive

&) USE Controller

USE Device (unavailable)

| PCI Device (unavailable)

B2, 5CSI Device (unavaiable)

Help | < Back | Mext > I Cancel

Install GigaVUE-FM on VMware ESXi
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Figure 12 vSphere Client: Selecting Ethernet Adapter

4. Inthe Adapter Type drop-down list, select an appropriate adapter type. Refer to Figure
13vSphere Client: Selecting Device Type.

(&) Add Hardware - ' p—— =2

Metwork Type
| What type of network do you want to add?

Device Tvpe [~ Adapter Type
Metwork connection Type: Im
Ready to Complete
Adapter choice can affect both networking performance and migration compatibility.
Consultthe VMware KnowledgeBase for moreinfarmation an choosing amang the
network adapters supported for various guest operatingsystems and hosts.

[~ Metwork Connection

' Named network with specified label:
IVM Network LI
" Legacy network:

| =l

Legacy network types are not fully compatible with migration between hosts.

Device Status
’7|7 Connect at power on

Help | < Back | Next > I Cancel

Figure 13 vSphere Client: Selecting Device Type

5. In the Named network with specified label drop-down list, select an appropriate network
and click Next.

The Network adapter 2 is added to GigaVUE-FM.
Increase the Memory

Based on the requirement, you can increase the memory of the GigaVUE-FM instance.

To increase the memory:

1. Right-click the GigaVUE-FM instance and select Edit Settings... Refer to Figure 14vSphere
Client: Edit Settings.

Install GigaVUE-FM on VMware ESXi
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Sl [ vesas5-aaa-26-40
B [ ea._0C

GigaVUE-FM50-22-89

o 102102017 i Summary | Resource Allocation | Performance | Tasks & Events | Alarms | Console.| Permissions | Maps | Storage Visws
2280 close tab [X
Pewer 3 ‘What is a Virtual Machine?
Guest 4 A virtual machine is a software computer that, like a
Snapshot L4 physical computer, runs an operating system and Virtusl Machines
= Open Console applications. An operating system installed on a virtual
[ EdtSettingsn machine is called a guest operaling system
Bl migrate.. Because every virtual machine is an isolated computing Cluster
Upgrade Viruzl Hardware environment, you can use virtual machines as desktop or
workstation environments, as 1esting environments, or to
B Clone.. consolidate server applicafions.
Template > . X Host
In vCenter Server, virtual machines run on hosts or
Fault Tolerance 3 clusters. The same host can run many virtual machines.
M Starage Profile 3 kl Datacenter
Add Permission... Crl+P vCenter Server
Alarrn 3 Basic Tasks vSphere Client
Report Performance... [+ Power on the virtual machine
Rename ¥ Edit virtual machine settings
Open in New Window... CtrlvAlteN Explore Further
Remove from Inventory
Delete from Disk | Learn more about virtual machines
| Learn how to install an operating system

Figure 14

vSphere Client: Edit Settings
2. Inthe Hardware tab, select Memory.

3. In Memory Configuration, increase the size of the memory as per your requirement. Refer to
the recommended size for your guest OS in the dialog box. Refer to Figure 15vSphere Client:
Increasing Memory.

@ GigaVUE-FM30-22-89 - Virtual Machine Properties = = £ ‘

Hardware |Ouﬁuns | Resources | Profiles | vServices I Virtual Machine Version: 8
—Memery Configuration
[ show All Devices Add... Remove
1011 GBrra Memory Size: 83: GE +
Hardware | Summary | 12 a5
Maximum recommended for this
B Memoy §182 18 | secall 4 uestos: witaa,
g ceus z M ded for best
Video card Video card 128 GEH - p:,ﬂm;,:;mrgn;z ;3, s
& VMCldevice Restricted 64 GBH Default recommended for this
e sCsI controller 0 Paravirtual < guestOs: 2GB.
% CD/DVD drive 1 [datastorel] GigaVUE-... 32 GBl Minimum recommended for this
& Harddisk1 Virtual Disk 16 GBH < guest 05: 512 MB,
B Network adapter1 WM Network
BB Network adapter2 WM Network 8GBH
4 GEH
2 GE 4
1GEH
512 ME [l
256 MEH
128 MBH
64 MEH
32 MBH
16 MEH
& ME H
4meH
Help oK Cancel

Figure 15 vSphere Client: Increasing Memory

4. Click OK.

Add vCPUs

Based on the requirement, you can add additional vCPUs to the GigaVUE-FM instance.

1. Right-click the GigaVUE-FM instance and select Edit Settings...

Install GigaVUE-FM on VMware ESXi
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2. Inthe Hardware tab, select CPUs. Refer to Figure 16vSphere Client: Adding vCPUs.

(3 GigaVUE-FMS0-22-89 - Virtual Machine Properties E=SEEE >
Herdware | Options | Resources | Profies | vservices | Virtual Machine Version: 8
™ Show All Devices Add... Remove Number of virtual sockets: 1 -
Hardware | Summary | Number of cores per socket: 2 -
BB Memory 8192 MB
O cros 2 | Total number of cores: 2
Video card Video card A - N I —
- Changing the number of virtual CPUs after the guest
= VMCIdevie Restricted 05 is installed might make your virtual machine
b e SCsI controller 0 Paravirtual unstable,
% €D/DVD drive 1 [datastorel] GigaWUE-...
& Hard disk1 Virtual Disk The virtual CPU configuration spedified on this page
B Network adapter1 VM Network might violate the license of the guest OS.
BB Network adapter2 VM Network
|
N
Help OK | Cancel |

Figure 16 vSphere Client: Adding vCPUs
3. Inthe Number of virtual sockets field, enter the appropriate number of sockets.

4. In the Number of cores per socket field, enter the appropriate number of cores per socket.

5. Click OK.

Install Third-Party Certificate

Use the following procedure to install a third-party certificate on GigaVUE-FM:

1. Generate a certificate and a private key file in pem format. Use the following command on
Linux or a Linux app (such as Cygwin) for generating the files:

openssl req -x509 -nodes -days 365 -newkey rsa:2048 -keyout privatekey.pem -out certificate.pem

2. Copy the contents of the certificate file. You will use the contents in Step .

NoTe: When you copy the contents, do not delete the EOL characters at the start of each
line.

3. Log in to the GigaVUE-FM CLI.
4. Execute the following steps from the shell prompt as a root user (sudo):

« Replace SSLCertificateFile: /etc/pki/tls/certs/localhost.crt

NOTE: In case of chain of certificates, bundle the server, intermediate, and root certificates
into a single certificate file before replacing the 1ocalhost.crt.
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« Replace SSLCertificateKeyFile: /etc/pki/tls/private/localhost.key
 Provide access to certificate: chmod 644
 Provide access to key: chmod 600

NoOTE: For chain of certificates, add the SSLCertificateChainFile directive to

/etc/httpd/conf.d/ssl.conf
sudo vim /etc/httpd/conf.d/ssl.conf.

Add the following line:
SSLCertificateChainFile /etc/pki/tls/certs/localhost.crt

« Restart apache as root: systemctl restart httpd

The system will now start using the newly installed certificate.

GigaVUE-FM uses a public key (cms.p12 file) to encrypt the Security Assertion Markup Language
(SAML) messages. You can either use the default public key available in GigaVUE-FM or generate a
new public key using the following command:

sudo openssl pkcsl2 -export -name CMS -out /etc/gigamon/cms.pl2 -inkey
/etc/pki/tls/private/localhost.key -in /etc/pki/tls/certs/localhost.crt -
passout pass:cmsl23

You will be prompted for a pass phrase for the localhost.key.

After the public key (cms.p12 file) is generated, place the file in the /etcigigamon directory.

Install GigaVUE-FM on VMware ESXi
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Install GigaVUE-FM on MS Hyper-V

This section describes how to install and configure GigaVUE-FM in a Microsoft Hyper-V environment.
It consists of the following main sections:

« System Requirements describes the hardware requirements.

« Install GigaVUE-FM for Microsoft Hyper-V describes the steps to install and deploy GigaVUE-
FM.

System Requirements

This section describes the hardware and virtual computing requirements for GigaVUE-FM. Before
installing GigaVUE-FM, ensure that a supported version of Windows Server is installed on hardware
that meets minimum requirements (see Windows Server Hardware Requirements for hardware
requirements).

Ensure that the GigaVUE-FM time is set correctly to ensure accuracy of the trending data that is
captured.

The Hyper-V implementations provided by the following Windows Server versions have been tested
and found to operate acceptably with GigaVUE-FM:

» Windows Server 2012 R2 and later

Windows Server Hardware Requirements

The following table describes the minimum requirements for the hardware on which Microsoft
Hyper-V runs GigaVUE-FM.

Minimum Hardware Requirements

Hypervisor Microsoft Hyper-V
CPU One or more 64-bit x86 CPUs with virtualization assist (Intel-VT or AMD-
V) enabled.

Note: To run GigaVUE-FM, hardware support for virtualization must be
enabled. Make sure that the BIOS option for virtualization support is not
disabled. For more information, see your BIOS documentation

Install GigaVUE-FM on MS Hyper-V 08
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Minimum Hardware Requirements

RAM At least 16GB
Disk Space At least 84GB shared (FC, iSCSI, NFS, or FCoE) or locally attached storage
(PATA, SATA, SCSI).
NoOTE: Increase the disk space depending on the configuration load
requirements for the given GigaVUE-FM instance.
Network At least one 1Gb NIC

NoTEe: Refer to the Microsoft documentation for information on enabling Hyper-V.

The following table lists the virtual computing resources that the Windows Server must provide for

each GigaVUE-FM instance.

Minimum Virtual Computing Requirements

Memory

Minimum 8GB memory

Virtual CPU

2vCPU

Virtual Storage for Guest

84GB Virtual IDE (the Hyper-V default)
» System Disk - 40GB

« Swap Disk - 4GB

 Data Disk - 40GB

Virtual Network Interfaces

1 VNIC using Hyper-V Virtualized NIC (the Hyper-V default)

Supported Browsers

GigaVUE-FM v3.5 has been tested on the following browsers:

Browser Version

Mozilla Firefox™ » Version 47
Apple® Safari® « Version 9.1
Google® Chrome® + Version 52
Microsoft Edge « Version 38

Notes:

Install GigaVUE-FM on MS Hyper-V
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Install GigaVUE-FM for Microsoft Hyper-V

The GigaVUE-FM software package for Microsoft Hyper-V environments is distributed as an 1ISO
image file. The following sections describes how to deploy a fresh installation of GigaVUE-FM on a
Hyper-V host and perform its initial configuration:

* Install GigaVUE-FM from an ISO Image File
* Initial GigaVUE-FM Configuration

Install GigaVUE-FM from an ISO Image File

Use the Hyper-V Manager to install the GigaVUE-FM ISO image file.

NoTe: The ISO image file must be stored in a location that is accessible to the Hyper-V Manager.

To create the Virtual Machine for GigaVUE-FM in Microsoft Hyper-V:

1. Click Start > Administrative Tools > Hyper-V Manager to open the Hyper-V Manager.
2. From the Actions pane, click New > Virtual Machine. Refer to Figure 10pening the Virtual
Machine Wizard.

The New Virtual Machine Wizard opens.

File Action View Help
e nE B
3 Hyper-V Manager ” Actions
i. W22 HVDERV ‘ Virtual M. i N
New v Virtual Machine... m T T = =
sage signed Memoy ime
Import Virtual Machine... Hard Disk... 2 2 24 New 4
Hyper-V Settings... Floppy Disk... & Impert Virtual Machine...
Virtual Switch Manager... %] Hyper-V Settings...
Virtual SAN Manager... Ll Z1 Virual Switch Manager...
Edit Disk.. (2| &l Virtual SAN Manager.
Inspect Disk... A Edit Disk..
Stop Service The selected vitual machine has no checkpoints. L inspect Dick.. _
Remove Server (W) Stop Service
Refresh 7 Remove Server
View » (3 Refresh
Help L= View »
Created:  8/10/20153:27:14PM Clustered: Mo H +ep
Versiom: 50
Generation: 1
=] Connect...
Notes: None
Z¢) Settings...
O stat
Summary |M9ﬂmy|Ndwuh‘wg|Wm| fs Checkpoint
<] " >|| 5 Move.. v
Displays the New Virtual Machine Wizard.

Figure 1 Opening the Virtual Machine Wizard

3. Read the notes on the Before You Begin screen (refer to Figure 2Before You Begin Screen), and
then click Next to continue.
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Before You Begin This wizard helps you create a virtual machine. You can use virtual machines in place of physical

. . computers for a variety of uses. You can use this wizard to configure the virtual machine now, and
Spedify Name and Location you can change the configuration later wsing Hyper-V Manager.
Specify Generation

To create a virtual machine, do one of the following:

: Y » Click Finish to create a virtual machine that is configured with default values,
Canfigure Networking « Click Next to create a virtual machine with a custom configuration.
Connect Virtual Hard Disk

Installation Options
Summary

[] Do not show this page again

< Previous | | Mext > | | Finish | | Cancel

Figure 2  Before You Begin Screen

4. After the Specify Name and Location page of the New Virtual Machine Wizard opens as
shown in Figure 3Name and Location Page, do the following:

a. Supply a descriptive name for the GigaVUE-FM virtual machine in the Name field.

By default, the virtual machine will be stored in the default configuration folder shown in
the Location text box. You can change this default location by checking the Store the
virtual machine in a different location check box and providing a custom path.

b. Click Next to continue.
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A

ol
ﬁ Specify Name and Location

Before You Begin Choose a name and location for this virtual machine.
Specify Name and Location The name is displayed in Hyper-¥ Manager. We recommend that you use a name that helps you easily
Sperify Generation identify this virtual machine, such as the name of the guest operating system or workload.
Assign Memory Name: |F|""|| |
Configure Networking You can create a fokder or use an existing folder to store the virtual machine, If you don't select a
Connect Virtual Hard Disk folder, the virtual machine is stored in the default folder configured for this server.
Installation Options [[] store the virtual machine in a different location
Summary Location: |C:‘ngramData‘Micrcsuﬁ\\nmduwszer-\f\ || Browse...

‘h If you plan to take checkpoints of this virtual machine, select a location that has enough free
space. Chedkpoints indude virtual machine data and may require a large amount of space.

[ <previous | [ next> || Fnsh | [ concel

Figure 3  Name and Location Page

5. On the Specify Generation page of the New Virtual Machine Wizard, select Generation 1 as

shown in Figure 4Specify Generation Page

NOTE: It is important to select Generation 1 and not Generation 2. Selecting
Generation 2 may lead to failure of the GigaVUE-FM installation process because the
CD Drive is presented as an SCSI device and not IDE.

[y
ﬁ Specify Generation
Before You Begin Choose the generation of this virtual machine.
precliliapeadlocaton @ Generation 1
Specify Generation This virtual machine generation provides the same virtual hardware to the virtual machine as in
ssian M . previous versions of Hyper-V.
Configure Networking O Generation 2

This virtual machine generation provides support for features such as Secure Boot, 5CSI boot, and
e PXE boot using a standard network adapter. Guest operating systems must be running at least

Installation Options Windows Server 2012 or 64-bit versions of 8.
Summary m Once a virtual machine has been created, you cannot change its generation.
[ <previous | [ mext> || Fmsh | [ cancel

Figure 4  Specify Generation Page
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6. Click Next to continue.

The Assign Memory page of the New Virtual Machine Wizardopens, which is shown in
Figure 5Assign Memory Page.

Before You Begin Specify the amount of memory to allocate to this virtual machine. You can spedify an amount from 32
. ) ME through 125438 MEB. To improve performance, specify more than the minimum amount
Specify Name and Location recommended for the operating system.

R Startup memory: ME

Assign Memory

Configure Metworking

Connect Virtual Hard Disk
Installation Options

[] Use Dynamic Memary for this virtual machine.

When you decide how much memaory to assign to a virtual machine, consider how you intend to
use the virtual machine and the operating system that it will run.

Summary

Figure 5  Assign Memory Page

7. Change the Memory assigned to this virtual machine to 16384 MB, and then click Next to
continue.

The Configure Networking page of the New Virtual Machine Wizardopens, which is shown
in Figure 6Configure Networking Page.
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Each new virtual machine indudes a network adapter. You can configure the network adapter to use a
virtual switch, or it can remain disconnected.

Connection: | Intel(R) 1350 Gigabit Network Connection - Virtual Switch vl

[ <previous | [ mext> || Fnsh | [ conce

Figure 6  Configure Networking Page

8. From the Connection drop-down list, select the virtual network to which GigaVUE-FM will
connect to, and then click Next to continue.

The Connect Virtual Hard Diskpage of the New Virtual Machine Wizard opens, which is
shown in Figure 7Connect Virtual Hard Disk Page.

i
ﬁ} Connect Virtual Hard Disk

Before You Begin A virtual machine requires storage so that you can install an operating system. You can specify the
Spedify — . storage now or configure it later by modifying the virtual machine’s properties.

® Create a virtual hard disk
Use this option to create a VHDX dynamically expanding virtual hard disk.

Name: |FM,v|'l:I)< |

----- and i Location: [C:\Users\Public\Documents|Hyper \virtual Hard Disks\ || erowse...
Size: 41| GB (Maxi 64
Summary ! ™

() Use an existing virtual hard disk
Use this option to attach an existing virtual hard disk, either VHD or VHDX format.

Location: |C:!Jsers‘ﬂ’ublic\DocunentsHyper-\'\mrmal Hard Disks}, Browse, ..

) Attach a virtusl hard disk later
Use this option to skip this step now and attach an existing virtual hard disk later,

[ <previous | [ mext> || Fnsh | [ cancel

Figure 7 Connect Virtual Hard Disk Page
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9. Select the Create a virtual hard disk option and set the Size to 41 GB.

You can accept the default Name and Location or customize them according to your needs.
When you have finished, click Next to continue.

The Installation Options page of the New Virtual Machine Wizardopens, which is shown in

Figure 8Install Options Page.

10. Use this dialog box to select the ISO image file for GigaVUE-FM. As shown in the figure Figure
8Install Options Page, set the following options:

a. Select the option Install an operating system from a bootable CD/DVD-ROM.

b. Setthe Media option to Image file (.iso).

c. Use the Browse button to navigate to the GigaVUE-FM ISO image file.

d. Click Next to continue.

S

ﬁ Installation Options

Before You Begin ‘You can install an operating system now if you have access to the setup media, or you can install it

Specify Name and Location iz
Specify Generation () Install an operating system later
Assign Memory (®) Install an operating system from a bootable CD/DVD-ROM
Configure Networking Media
Connect Virtual Hard Disk ) Physical CD/DVD drive: | |
Installation Options ® Image file (iso): ~: \Users\Administrator \Downloads\fma.isol Erowse. ..

Media

() Install an operating system from a bootable fioppy disk

virtual floppy disk (. vid):

O Install an operating system from a network-based installation server

<previous | [ Next> || Fnsh | [ conce

Figure 8 Install Options Page

After you click Next, the summary page of the New Virtual Machine Wizardopens,

showing the settings that you configured for the GigaVUE-FM virtual machine. An example

is shown in Figure 9Summary Page.
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11.

Before You Begin You have successfuly completed the New Virtual Machine Wizard. You are about to create the
Specify Name and Location AT
Specify Generation Description:
Assign Memory MName: M
= Generation: Generation 1

Con Networking

SIss Memory: 4096 MB
Connect Virtual Hard Disk Network: Intel(R) 1350 Gigabit Network Connection - Virtual Switch

Installation Options Hard Disk: C:\Jsers\Public\Documents\Hyper-V\Virtual Hard Disks\FM.vhdx (VHDX, dynamici

Operating System: Wil be installed from C:\Users'\Administrator\Downloads\fma.iso
< [ >

LS
e
ﬁ Completing the New Virtual Machine Wizard

To create the virtual machine and dose the wizard, dick Finish.

<Pmms|| Next > Finish || Cancel

Figure 9  Summary Page

Click Finish to create the GigaVUE-FM virtual machine as configured. Alternatively, you can use
the Previous button to go back and change settings.

The New Virtual Machine Wizard only creates the GigaVUE-FM virtual machine, returning you
to the Hyper-V Manager when creation is complete. The new GigaVUE-FM virtual machine is
listed in the Action pane by the name you supplied during installation.

The procedures given below will take you through the steps of adding an additional virtual
hard disk and actually installing GigaVUE-FM.

Add Additional Virtual Hard Disk and Install GigaVUE-FM

To add an additional virtual hard disk and install GigaVUE-FM:

1.

In Hyper-V Manager, from the Actions pane, select the newly added GigaVUE-FM virtual
machine, and then click Settings.

In the Settings page, select IDE Controller 0.

In the IDE Controller pane that appears to the right, select Hard Drive, and then click Add.
Refer to the following figure:
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New »

e |Import Virtual Machine...
|§| Hyper-V Settings...
g.: Virtual Switch Manager...
ﬂl Virtual SAN Manager...
ﬁ Edit Disk...
E Inspect Disk...
@ Stop Service
75 Remove Server
4 Refresh

View »
n Help

5 Connect...

1@

Start

i

Checkpoint
Maove..,
Export...
Rename...
Delete..,

Enable Replication...

Bty e

Help

| GigaVUE-FM-53

V4G

% Hardware

*‘ﬂ Add Hardware
& BIOS
Boot from CD
[ fMemary
16384 MB
] R Processor
1 Virtual processor

= =1 IDEConmolero 4]
[® = Hard Drive

GigaVUE-FM-5.8.vhdx
= EE IDE Contraller 1
§* DVD Drive

®2 5CSI Contraller
[+ @ Metwork Adapter

T com1

None
T comz
None
!! Diskette Drive
None
s +

gigamon-gigavue-fm-5.8.0...

Intel(R) 1350 Gigabit Network ...

m Mame

GigaVUE-FM-5.8

\ﬁ Integration Services
Some services offered

] Checkpoint File Location

aé Smart Paging File Location

I Automatic Start Action
Restart if previously running

Figure 10 Navigating to Add Additional Hard Disk

C:\ProgramData\MicrosoftiWin.. .

C:\ProgramData\Microsoftiwin.. .

El IDE Controller

You can add hard drives and CD/DVD drives to your IDE controller.
Select the type of drive you want to attach to the controller and then dick Add.

DD Drive

(N
You can configure a hard drive to use a virtual hard disk or a physical hard disk after
you attach the drive to the contraller.

A new Hard Drive entry is added under IDE Controller 0.

4. Select the Hard Drive entry.

5. In the Hard Drive pane that appears to the right, select Virtual hard disk, and then click New
as shown in the following figure:
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| GigaVUE-FM-5.8 v 4 p @

# Hardware & Hard Drive
‘{‘ﬂ Add Hardware
1% BIOS

Boot from CD

[ Memaory
16384 MEB

= R Processor
1 Virtual processor Media

= iEll IDE Controller 0 You can compact, convert, expand, merge, reconnect or shrink a virtual hard disk
# & Hard Drive by editing the assodated file. Specfy the full path to the file.

GigaVUE-FM-5.8.vhdx Virtual hard disk:

You can change how this virtual hard disk is attached to the virtual machine. If an
operating system is installed on this disk, changing the attachment might prevent the
wvirtual machine from starting.

Controller: Location:
|IDE Controller 0 v | | 1 (in use)

5 N Controller 1 | Edit || Inspect || Browse... |
@4 DVD Drive
gigamon-gigavue-fm-5.5.0... () Physical hard disk:

B 5CSI Controller | |

I+ [H] Metwork Adapter

Intel(R) 1350 Gigabit Network ... ﬂ If the physical hard disk you want to use is not listed, make sure that the

l? COM 1 disk is offline. Use Disk Management on the physical computer to manage
physical hard disks.

MNone

COM 2
‘? Mane To remove the virtual hard disk, dick Remove. This disconnects the disk but does not
delete the assodated file.

I Disketts Drive

Management
|1 Mame
GigaVLUE+FM-5.8
7| Integration Services
Some services offered
##.| Checkpoint File Location
C:\ProgramData\Microsoft\in. ..
amé Smart Paging File Location
C:\ProgramData\Microsoft\in. ..

Figure 11 Navigating to the New Virtual Hard Disk Wizard
The New Virtual Hard Disk Wizard opens.
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Before You Begin

Before You Begin This wizard helps you create a new virtual hard disk. Virtual hard disks provide storage for virtual
] machines and are stored on physical media as .vhd or .vhdx files.
Choose Disk Format

Choose Digk Type
Specify Mame and Location
Configure Disk

Summary

[] Do not show this page again

< Previous | | Mext = ‘ | Finish | ‘ Cancel

Figure 12 New Virtual Hard Disk Wizard

6. Click Next to go to the Choose Disk Format page of the wizard.
7. Select the required format that you want to use for the virtual hard disk, and then click Next.

The Choose Disk Type page of the wizard appears.
8. Select the required disk type for the virtual hard disk, and then click Next.
The Specify Name and Location page of the wizard appears.

9. Specify a unique name for the virtual hard disk, and then browse and select the location where
you want to save the disk.
10. Click Next. The Configure Disk page of the wizard appears.
11. You can choose one of the following options to configure the virtual hard disk:

« Create a blank virtual hard disk of size 41 GB.

« Choose a physical hard disk from which you can copy the contents into the new virtual
hard disk.

 Browse and select a virtual hard disk from which you can copy the contents into the new
virtual hard disk.
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12. Click Next to exit the New Virtual Hard Disk Wizard.
13. Click OK. The GigaVUE-FM installation begins as shown in the following figure:

t& GigaVUE-FM-5.8 on WIN-G
File Action Media Clipboard Wiew Help

€000 NPk

NHOTE: fibout to install GigallJE-FM on this system.

Writing GigalWE-FM image to boot diszk.
This will take at least 18-Z8 minutes. Please wait...

Figure 13 GigaVUE-FM Installation Begins

It may take several minutes for the installation to complete. The system will reboot after the
installation is completed.

Connect and Power On the GigaVUE-FM Virtual Machine

The next step is to connect to the GigaVUE-FM virtual machine from within Hyper-V Manager and
start it. This begins the actual installation of the GigaVUE-FM Virtual Appliance from the connected
ISO image file. Once GigaVUE-FM finishes installing from the ISO image file, you will then
disconnect the ISO image file and restart the virtual machine.

1. In Hyper-V Manager, locate the Virtual Machines entry in the results pane, right-click the
GigaVUE-FM virtual machine, and click the Connect option.

2. The Virtual Machine Connection tool opens for the GigaVUE-FM virtual machine.
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=4
File Action View Help
= 2|m HE

33 Hyper-V Manager
33 W2012-HYPERV

Hyper-V Manager =|l=l]
= ; : Actions
Virtual Machines W2012-HYPERV -
Name - State CPU Usage Assigned Memory Uptime New
4 m Off
u_-inualh1achine...
= FM on W2012-HYPERV - Virtual Machine Connection =1 Settings
File Action Media View Help itch Manager..
(]
= = AN Manager...
isk... =
sice
Server
»
The virtual machine 'FM' is turned off
-
To start the virtual machine, select "Start' from the Action menu
int

3. Select Action > Start to start the GigaVUE-FM virtual machine from the Virtual Machine
Connection tool.

4. The GigaVUE-FM virtual machine powers on. You can monitor the progress of the system start
in the Virtual Machine Connection tool.

The system power-on can take several minutes as GigaVUE-FM is installed from the ISO image
file. Disconnect the media before Powering On as shown below:

(]

-’

Status: Off

Install GigaVUE-FM o
Install GigaVUE-FM fo

% FM on W2012-HYPERV - Virtual Machine Connection \;Ii-
File Action Clipboard  View Help

Diskette Drive ¥ Insert Disk...

The virtual machine 'FM' is turned off

To start the virtual machine, select "Start’ from the Action menu

n MS Hyper-V
r Microsoft Hyper-V
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Disconnect the ISO Image File

It is important to disconnect the ISO image file before you power on GigaVUE-FM again so you
don't have to go through the image install process again. Disconnect the ISO image file as follows:

1. In Hyper-V Manager, locate the Virtual Machines entry in the results pane and select the
GigaVUE-FM virtual machine.

2. Inthe Actions pane, click the Settings entry under the GigaVUE-FM virtual machine name.
A Settings dialog box for the GigaVUE-FM virtual machine appears.

3. Select the DVD Drive entry in the panel on the left of the Settings dialog box and change its
setting from Image file to None, as shown in the figure below.

4. Click the OK button to apply the changes.

This concludes the installation procedure for GigaVUE-FM on Hyper-V. The next step is to power on
the virtual machine and perform its initial configuration, as described in Initial GigaVUE-FM
Configuration .

IMPORTANT: Clear the browser cache before logging in to GigaVUE-FM.

Initial GigaVUE-FM Configuration

After you have deployed a new GigaVUE-FM instance, you need to perform an initial configuration
before you can start using GigaVUE-FM. This procedure only needs to be performed once for each
GigaVUE-FM instance deployed.

NoOTE: Use Care When Shutting Down or Rebooting a GigaVUE-FM. Never directly Power-
Off the virtual machine. For Microsoft Hyper-V environment, you cannot use any of the reset,
or turn-off hooks. Using either of these may lead to corruption that will prevent proper
GigaVUE-FM operation.

The best ways to shutdown a GigaVUE-FM on Hyper-V is to use either Shutdown or Ctrl+Alt+Del
from the Action button on the virtual console.

To perform the initial configuration:

1. Click Start > Administrative Tools > Hyper-V Manager.

NoTE: Make sure you have already disconnected the ISO image file used to install
GigaVUE-FM. Refer to Disconnect the ISO Image File for details.

Install GigaVUE-FM on MS Hyper-V 42
Install GigaVUE-FM for Microsoft Hyper-V



GigaVUE-FM Installation and Migration Guide

2. Locate the Virtual Machines entry in the results pane, right-click the GigaVUE-FM virtual
machine, and click the Connect option. The Virtual Machine Connection tool opens for the

GigaVUE-FM virtual machine.
3. Select Action > Start to start the GigaVUE-FM virtual machine from the Virtual Machine

Connection tool. The GigaVUE-FM virtual machine powers on and displays a login prompt.
4. Log in as admin with password admin123A!. You will be prompted to change your password.
After you change and confirm your password, perform the following steps:

a. Run the fmctl jump-start command. The Initial System Configuration screen appears as
shown in the following figure:

unconf igured-—gigavwue-fm

yes

H._centos.pool .ntp.org 1.centos.poo
4

b. Provide a unique hostname for GigaVUE-FM. Note that the hostname may contain
letters, numbers, periods (.), and hyphens (-), but may not begin with a hyphen. No
other special characters are permitted.

c. Enter the required domain name.
d. Decide whether to use DHCP for the management interface. Choose one of the
following options:
« If you enter yes, the IPv4 Address or IPv6 Address, CIDR, Gateway, DNS Servers,
and Search Domains are dynamically set up for the management interface.
« If you enter no, you must provide the following:
i. IPv4 Address or IPv6 Address, and the respective CIDR and Gateway.
ii. Inthe DNS Servers field, provide the address of any additional name servers
required. Enter the set of IP addresses with spaces in between.
iii. In the Search Domains field, provide the required DNS domains with spaces in

between.
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e. You can choose to either enable or disable NTP. In the Enable NTP field, enter one of
the following:

« Yes—Use NTP to synchronize the time between GigaVUE-FM virtual machine and the
NTP server. In the NTP Servers and NTP Version fields, enter the NTP server address
and the version number of the NTP server.

« No—you can skip the next step and directly save your configurations.

f. Select OK to save your configurations.
g. Reboot your GigaVUE-FM virtual machine.

You can now access GigaVUE-FM by opening a browser and entering its IP address (the
IP address you specified).
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Install GigaVUE-FM on KVM

This section describes how to install and configure GigaVUE-FM in a KVM environment. It consists of
the following main sections:

« System Requirements describes the hardware requirements.
* Install GigaVUE-FM for KVM describes the steps to install and deploy GigaVUE-FM.

« Initial GigaVUE-FM Configuration describes the steps to start GigaVUE-FM instance and
configure it.

Limitations

You can install GigaVUE-FM in a KVM environment, but you cannot access GigaVUE-FM through CLI
in a KVM environment using SSH. In KVM, you can only access the GigaVUE-FM CLI using the VNC
console.

System Requirements

This section describes the hardware and virtual computing requirements for GigaVUE-FM. Ensure that
the GigaVUE-FM time is set correctly to ensure accuracy of the trending data that is captured.

Linux Server Hardware Requirements

The following table describes the minimum requirements for the hardware on which KVM runs
GigaVUE-FM.

Minimum Hardware Requirements

Hypervisor KVM
Supported (tested on previous versions of GigaVUE-FM)
+ v2.0.0
CPU One or more 64-bit x86 CPUs with virtualization assist (Intel-VT or AMD-
V) enabled.

Note: To run GigaVUE-FM, hardware support for virtualization must be
enabled. Make sure that the BIOS option for virtualization support is not
disabled. For more information, see your BIOS documentation.
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Minimum Hardware Requirements

RAM At least 16GB.
Disk Space At least 84GB shared (FC, iSCSI, NFS, or FCoE) or locally attached storage
(PATA, SATA, SCSI).
NoOTE: Increase the disk space depending on the configuration load
requirements for the given GigaVUE-FM instance.
Network At least one 1Gb NIC.

The following table lists the virtual computing resources that the Linux Server must provide for each

GigaVUE-FM instance.

Minimum Virtual Computing Requirements

Memory Minimum 8GB memory
Virtual CPU 2 vCPU
Virtual Storage for Guest 84GB

« System Disk - 40GB
» Swap Disk - 4GB
« Data Disk - 40GB

Virtual Network Interfaces

One vNIC

Supported Browsers

GigaVUE-FM has been tested on the following browsers:

Browser Version

Mozilla Firefox™ » Version 47
Apple® Safari® + Version 9.1
Google®Chrome® + Version 52
Microsoft Edge » Version 38

Notes:

« Only the browsers that support TLS v1.2 can access GigaVUE-FM.

« Internet Explorer 11 (IE11) is deprecated for security reasons and is no longer supported. IE users

are strongly encouraged to switch to Microsoft Edge.

Install GigaVUE-FM on KVM
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Install GigaVUE-FM for KVM

The GigaVUE-FM software package for KVM environments is distributed as an ISO image file. The
following sections describes how to deploy a fresh installation of GigaVUE-FM on a KVM host and
perform its initial configuration:

* Install GigaVUE-FM from an ISO Image File
* Initial GigaVUE-FM Configuration

These steps are only valid for new installations of GigaVUE-FM.

Install GigaVUE-FM from an ISO Image File

Use the Virtual Machine Manager to install the GigaVUE-FM ISO image file.

NoTE: The ISO image file must be stored in a location that is accessible to the Manager.

To create the Virtual Machine for GigaVUE-FM in KVM:

NoOTE: These instructions use “Virtual Machine Manager” to create and manage the virtual
machines (VMs).

1. Open the Virtual Machine Manager, and then click the Create a new virtual machine icon as
shown in the following figure:

Virtual Machine Manager

5] mom b

Name 4 (CPUusage

v QEMU/KVM

The New Virtual Machine Wizard opens.

2. Select Local install media (ISO image or CDROM), and then click Forward to continue.

Install GigaVUE-FM on KVM 47
Install GigaVUE-FM for KVM



GigaVUE-FM Installation and Migration Guide

New VM

m Create a new virtual machine

Connection: QEMU/KVM

Choose how you would like to install the operating system

© Local install media (IS0 image or CDROM)
Network Install (HTTP, FTP, or NFS)
Network Boot (PXE)
Import existing disk image

P Architecture options

Cancel Back Forward

3. Browse and select the location from where to upload the GigaVUE-FM ISO image, and then
select the Automatically detect operating system based on install media check box.

New VM

m Create a new virtual machine

Locate your install media
Use CDROM or DVD

© Use ISO image:
[home/kvm/gigamon-gigavue-fm-5.9.00-17000; + | | Browse...

Automatically detect operating system based oninstall media

OS type: Unknown
Version: Unknown

Cancel Back Forwaﬁj

Click Forward to continue.

4. Set the Memory and CPU Settings.

Install GigaVUE-FM on KVM
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New VM

m Create a new virtual machine

Choose Memory and CPU settings

Memory (RAM): .3192 ==k

Up to 128567 MIB available on the host

CPUs: | 2 -+

Up to 64 available

Cancel Back ~ For%ard

Click Forward to continue.

5. Select the Enable storage for this virtual machine check box, and set the Size to 40Gb.

Mew VM

m Create a new virtual machine

Enable storage for this virtual machine
© Create a disk image for the virtual machine

40.0 = | 4 | GiB

1794.6 GiB available in the defaulkt location

Select or create custom storage

cancel Back [ Fnﬂ}ard J
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Click Forward to continue.

6. On the next screen, complete the following:

a. Enter a unique name for the virtual machine.

b. Select the Customize configuration before install check box.

c. From the Network Selection drop-down list, select the required network communication

option.
d. From the Source mode drop-down list, select Bridge.

e. Click Finish.

New VM

m Create a new virtual machine

Ready to begin the installation

MName: | generic

0S: Generic
Install: Local CDROM/ISO
Memory: 8192 MIB
CPUs: 2
Storage: 40.0 GiB /var/lib/libvirt/images/generic.qcow?

Customize configuration before install

« Network selection
Hosk device enp59s0f0: macvtap »

Source mode: | Bridge 3

In most configurations, macvtap does not
0 work For host to guest network
communication.

Cancel Back [ Flnﬁﬁ - |

The summary screen appears as shown in the following figure:
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generic on QEMU/KVM

of Begin Installation e Cancel Installation

B overview Virtual Disk
G CPUS Source path: /var/lib/libvirt/images/generic.qcow2
Device type: IDE Disk 1
&= Memory Storage size: Unknown
Boot Options Readonly:
IDE CDROM 1 ¥ Advanced options B
NIC :77:08:e9 Disk bus: | IDE 4
M Display Spice Serial number: | |
i Sound iché /
Storage format: | gcowz |

= Console
¥ Performance options

g:—_'; Channel spice

—r - Cache mode: | Hypervisor default »

- \ideo — —

! Controller USB 0 10 mode: | Hypervisor default »

@ useredirector 1

@ USB Redirector 2

_ Add Hardw.?\r‘e n Remove Cancel Apply

7. Verify the options that you have selected, and then click Add Hardware to add the second
disk.
8. Inthe Add New Virtual Hardware screen, set the disk size to 40Gb.
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Add New Virtual Hardware

M cController

Network © Create a disk image for the virtual machine

& Input 40.0 - | + | GiB
_- Graphics 1794.6 GiB available in the default location
W sound
@ serial Select or create custom storage
=@l Parallel Manage.
@ console
=48] channel Device type: | ] Disk device
=% USB Host Device
/% PCI Host Device EEENTE G

M video
M watchdog ~ Advanced options
i@ Filesystem Cache mode: Hypervisor default »

@ Smartcard
@ usBRedirection
& TPM

) RNG

|%» Panic Notifier

Cancel

Finish

#

9. Click Finish. The summary screen appears again where you can verify the details of IDE Disk 2

that you added. Click Begin Installation.

|J Begin Inf.\tallatlonl 6 Cancel installation
by

B overview Virtual Disk

‘D CPUs Source path: fvar/lib/libvirt/images/generic.qcow2

Device type: IDE Disk 1

&8 Memory Storage size: Unknown
Boot Options Readonly:
Shareable:
_ IDECDROM 1 ¥ Advanced options

| i IDE Disk 2 Disk bus: |IDE
- NIC:77:08:e9

Serial number; |

Bl Display Spice

i Sound iché

Storage format: | gcow2

w Performance options

;':—i'g Console f
o Cache mode: | Hypervisor default
&3 Channel spice =

Bl video OXL 10 mode: | Hypervisor default

H Controller USB 0
@ useredirector 1
@ ussredirector 2

Add Hardware
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Once the installation is complete, the virtual machine launches.

Initial GigaVUE-FM Configuration

After you have deployed a new GigaVUE-FM instance, you need to perform an initial configuration
before you can start using GigaVUE-FM. This procedure only needs to be performed once for each
GigaVUE-FM instance deployed.
To perform the initial configuration:

1. Open Virtual Machine Manager.

2. Locate the Virtual Machines entry in the results pane, right-click the GigaVUE-FM virtual
machine, and click the Open option.

The Virtual Machine Connection tool opens for the GigaVUE-FM virtual machine.
3. Open the GigaVUE-FM virtual machine from the Virtual Machine tool.
4. The GigaVUE-FM virtual machine powers on and displays a login prompt.

5. Log in as admin with password admin123A!!. You will be prompted to change your password.
After you change and confirm your password, perform the following steps:

a. Run the fmctl jump-start command. The Initial System Configuration screen appears as
shown in the following figure:

unconf igured-gigawue—fm

yes

H._centos.pool .ntp.org 1.centos.poo
4

b. Provide a unique hostname for GigaVUE-FM. Note that the hostname may contain
letters, numbers, periods (.), and hyphens (-), but may not begin with a hyphen. No
other special characters are permitted.
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c. Enter the required domain name.
d. Decide whether to use DHCP for the management interface. Choose one of the
following options:

« If you enter yes, the IPv4 Address or IPv6 Address, CIDR, Gateway, DNS Servers,
and Search Domains are dynamically set up for the management interface.

« If you enter no, you must provide the following:

i. IPv4 Address or IPv6 Address, and the respective CIDR and Gateway.
ii. Inthe DNS Servers field, provide the address of any additional name servers
required. Enter the set of IP addresses with spaces in between.
iii. In the Search Domains field, provide the required DNS domains with spaces in
between.
e. You can choose to either enable or disable NTP. In the Enable NTP field, enter one of
the following:

« Yes—Use NTP to synchronize the time between GigaVUE-FM virtual machine and the
NTP server. In the NTP Servers and NTP Version fields, enter the NTP server address
and the version number of the NTP server.

« No—you can skip the next step and directly save your configurations.

f. Select OK to save your configurations.
g. Reboot your GigaVUE-FM virtual machine.

You can now access GigaVUE-FM by opening a browser and entering its IP address (the
IP address you specified).

Setting the Admin Password for the
GigaVUE-FM Shell

When installing GigaVUE-FM from the command line, you will be prompted to set the admin
password. This topic describes the requirements for this password.

NoTE: The password that you set from the GigaVUE-FM shell is applicable only to the
GigaVUE-FM shell. To access the GigaVUE-FM Ul, the default username is admin and
password is admin123All You can change the password when you first login to the GigaVUE-
FM UL

The admin password must be a minimum of 11 characters and a maximum of 30 characters. The
characters must include at least:

o One numerical character
« One upper case character
« One lower case character
« One special character

If the password does not meet the complexity requirements:
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« The system does not display any error message.

« The parameters configured above are not passed on to the GigaVUE-FM except the host name
parameter.

« The static IP addresses that were configured originally will be unavailable after GigaVUE-FM is
deployed.

Migrate GigaVUE-FM

This section provides information about migrating your GigaVUE-FM to the latest version. Refer to
the following sections for details:

« Migration Overview

« Plan Your Migration

« Migration—Rules and Notes

« Supported Migration and Upgrade Paths

« GigaVUE-FM Migration on VMware

« GigaVUE-FM Migration on Hardware Appliance
« GigaVUE-FM Migration on AWS

GigaVUE-FM migration is supported only on VMware ESXi, GigaVUE-FM Hardware Appliance, and
AWS platforms.

Migration Overview

Starting with release 5.8.00, GigaVUE-FM introduces several significant changes, which include
improvements in usability and performance. These changes include upgrading and replacing
databases and changing the underlying operating system. So, you must migrate your existing
configurations and data such as audit logs, events, syslogs, and statistics from your current GigaVUE-
FM version (either 5.7 or lower) to the latest version of GigaVUE-FM. You cannot directly upgrade
your GigaVUE-FM instance to the latest version. You must first upgrade to a special migration version
that provides the tools to manage and perform the migration. You can then upgrade to the latest
version of GigaVUE-FM. Refer to Supported Migration and Upgrade Paths.

Plan Your Migration

This section will help you plan your migration. It provides details about the scope of the migration,
the best migration method to use for your deployment, and how to complete the migration
process.

Migrate GigaVUE-FM 5§
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Refer to the following sections for details:

S.No | Purpose Refer to:

1. Ensure that you meet the migration requirements « Migration—Rules and Notes
and also, keep in mind the limitations before starting
the migration process.

Determine the migration and upgrade path. » Supported Migration and Upgrade Paths

Complete the migration process. + GigaVUE-FM Migration on VMware
+ GigaVUE-FM Migration on Hardware Appliance
» GigaVUE-FM Migration on AWS

Migration—Rules and Notes

Keep in mind the following rules and notes before you proceed with migration:

« Migration to the latest version of GigaVUE-FM is supported only on VMware ESXi, GigaVUE-FM
Hardware Appliance, and AWS platforms.

« The minimum size of hard disk for VMware, AWS, and GigaVUE-FM Hardware Appliance is
40Gb.

« Ensure that you plan for a maintenance window depending on the size of the data that you
plan to migrate and the network latency.

Following table provides a guideline for the maintenance window that you can refer to when
you plan for migration:

Note that the actual migration time may vary depending on your configurations.

Data Set Statistics Management | Estimated Migration Time

Loss Time Loss Time

Environment 1

No.of nodes 2 10 minutes 5 minutes « 2 hours (for 25 days of data)
No.of Ports 6 « 35 minutes (for 7 days of data)
No.of Maps 6

No.of Events 1000

No.of Syslogs 1000

No.of Audit logs 1000

Environment 2
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Data Set Statistics Management | Estimated Migration Time
Loss Time Loss Time

No.of nodes 40 1 hour 5 minutes « 8hours (for 25 days of data)
No.of Ports 2000 « 4 hours (for 7 days of data)
No.of Maps 1000
No.of Events 10000
No.of Syslogs 10000
No.of Audit logs 10000

Environment 3

No.of nodes 300 3 hours 5 minutes « 10 hours (for 7 days of data)
No.of Ports 12000

No.of Maps 6000

No.of Events 10000

No.of Syslogs 10000

No.of Audit logs 10000

 The custom SSL certificates and private keys will not be migrated. You must upload them
manually. For instructions, refer to Install Third-Party Certificate.

« Any configurations that you have set up using DHCP will not be migrated.

« If you have associated the IP address of your current version of GigaVUE-FM to the IP interface,
after the migration is completed, you must manually associate the IP address of the new
GigaVUE-FM to the IP interface.

* It is recommended to upgrade GigaVUE-FM using the local admin credentials and set the First
Priority field under the Authentication Priority section to Local. Refer to the "Configure AAA
Authentication Options" section in the GigaVUE Administration Guide.

Supported Migration and Upgrade Paths

Use the following table to determine the supported migration and upgrade path for your current
version of GigaVUE-FM:

From To Special Migration | Supported Upgrade Path
GigaVUE-FM GigaVUE-FM Version of
Version Version GigaVUE-FM
5.9.xx 5.10.xx N/A 5.9.xx > 5.10.xx
5.8.xx 5.10.xx N/A 5.8.xx > 5.10.xx
5.8.xx 5.9.xx N/A 5.8.xx > 5.9.xx
5.7.xx 5.10.xx 5.7.02.21 5.7.xx > 5.7.02.21 > 5.10.xx
5.7.xx 5.9.01 5.7.02.12 5.7.xx > 5.7.02.12 > 5.9.01
Migrate GigaVUE-FM 57

Supported Migration and Upgrade Paths



GigaVUE-FM Installation and Migration Guide

From To Special Migration | Supported Upgrade Path
GigaVUE-FM GigaVUE-FM Version of
Version Version GigaVUE-FM
5.7.xx 5.9.00 5.7.02.11 5.7.xx > 5.7.02.11 > 5.9.00
5.7.xx 5.8.01 5.7.02.01 5.7.xx > 5.7.02.01 > 5.8.01
5.7.xx 5.8.00 5.7.01.01 5.7.xx > 5.7.01.01 > 5.8.00
5.6.xx 5.10.xx 5.7.02.21 5.6.xx > 5.7.02.21 > 5.10.xx
5.6.xx 5.9.01 5.7.02.12 5.6.xx > 5.7.02.12 > 5.9.01
5.6.xx 5.9.00 5.7.02.11 5.6.xx > 5.7.02.11 > 5.9.00
5.6.xx 5.8.01 5.7.02.01 5.6.xx > 5.7.02.01 > 5.8.01
5.6.xx 5.8.00 5.7.01.01 5.6.xx > 5.7.01.01 > 5.8.00
5.5.xx 5.10.xx 5.7.02.21 5.5xx > 5.6.01 > 5.7.02.21 > 5.10.xx
-or-
5.5xx > 5.7.02 > 5.7.02.21 > 5.10.xx
5.5.xx 5.9.01 5.7.02.12 5.5.xx > 5.6.01 > 5.7.02.12 > 5.9.01
-or-
5.5.xx > 5.7.02 > 5.7.02.12 > 5.9.01
5.5.xx 5.9.00 5.7.02.11 5.5xx > 5.6.01 > 5.7.02.11 > 5.9.00
-or-
5.5xx > 5.7.02 > 5.7.02.11 > 5.9.00
5.5.xx 5.8.01 5.7.02.01 5.5xx > 5.6.01 > 5.7.02.01 > 5.8.01
-or-
5.5xx > 5.7.02 > 5.7.02.01 > 5.8.01
5.5.xx 5.8.00 5.7.01.01 5.5xx > 5.6.01 > 5.7.01.01 > 5.8.00
-or-
5.5xx > 5.7.02 > 5.7.01.01 > 5.8.00
5.4.xx 5.10.xx 5.7.02.21 5.4.xx > 5.6.01 > 5.7.02.21 > 5.10.xx
-or-
5.4.xx > 5.7.02 > 5.7.02.21 > 5.10.xx
5.4.xx 5.9.01 5.7.02.12 5.4.xx > 5.6.01 > 5.7.02.12 > 5.9.01
-or-
5.4.xx > 5.7.02 > 5.7.02.12 > 5.9.01
5.4.xx 5.9.00 5.7.02.11 5.4.xx > 5.6.01 > 5.7.02.11 > 5.9.00
-or-
5.4.xx > 5.7.02 > 5.7.02.11 > 5.9.00
5.4.xx 5.8.01 5.7.02.01 5.4.xx > 5.6.01 > 5.7.02.01 > 5.8.01
-or-
5.4.xx > 5.7.02 > 5.7.02.01 > 5.8.01
5.4.xx 5.8.00 5.7.01.01 5.4.xx > 5.6.01 > 5.7.01.01 > 5.8.00
-or-
5.4.xx > 5.7.02 > 5.7.01.01 > 5.8.00

Migrate GigaVUE-FM
Supported Migration and Upgrade Paths



GigaVUE-FM Installation and Migration Guide

NoTE: For deployments with GigaVUE-FM 5.3.xx or lower, upgrade to GigaVUE-FM 5.4.xx
and then follow the upgrade path listed in the above table to migrate to the latest version of
GigaVUE-FM. Refer to the “Installation and Upgrade” section in the GigaVUE-FM and
GigaVUE-VM User’s Guide of the respective versions.

GigaVUE-FM Migration on VMware

Use this option if your current instance of GigaVUE-FM is running on VMware ESXi. Migrating using
this option minimizes the downtime and the loss of statistical data. For details about the supported
special migration version, refer to Supported Migration and Upgrade Paths.

VMware Migration—System Requirements and Prerequisites

« Upgrade your existing GigaVUE-FM instance to the special migration version of GigaVUE-FM.
Before upgrading, ensure that you have two Virtual CPUs (vCPU) and a minimum of 8Gb RAM.

* Deploy a new GigaVUE-FM with the latest version using an OVA file.

NoTE: To obtain the required software images, register on the customer portal and
download the software.

« Set up your remote authentication servers to work with the latest version of GigaVUE-FM.

« Both instances of GigaVUE-FM must be identical in terms of hardware resources and that they
must be reachable to each other.

« Set up the same username and password to access both, GigaVUE-FM Ul and GigaVUE-FM
Shell at least till the migration is complete.

« Ensure that you use the same password for both the instances of GigaVUE-FM.

« Configure NTP to synchronize the time of both the GigaVUE-FM instances.

Migration on VMware—At-a-Glance

Following is an at-a-glance view of the tasks that you must perform to migrate to the latest version
of GigaVUE-FM:

Step 1: Perform the GigaVUE-FM backup to an archive server. For instructions on how to backup the
data, refer to the “Backup Immediately” section in the GigaVUE-OS and GigaVUE-FM Administration
Guide.
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Step 2: Upgrade your existing GigaVUE-FM instance to the special migration version of GigaVUE-FM.
For details about the supported special migration version and the upgrade path, refer to Supported

Migration and Upgrade Paths. For upgrade instructions, refer to the Upgrade an Existing GigaVUE-FM
Deployment.

Step 3: Deploy a new GigaVUE-FM with the latest version using an OVA file. For installation
instructions, refer to the Deploy GigaVUE-FM from an OVA File. Ensure that the password has a
minimum of 11 characters and they must include at least:

o One numerical character
« One upper case character
o One lower case character
« One special character

Step 4: Log in to the special migration version of GigaVUE-FM and start the migration process. The
data and the configuration files migrate to the latest version of GigaVUE-FM.

Step 5: After the migration is complete, decommission the GigaVUE-FM instance with the special
migration version immediately to avoid dual connection from both GigaVUE-FM instances.

Step 6: This step is applicable only for VMware NSX-V platform managed by the special migration
version of GigaVUE-FM instance. Configure the IP address and SHA-1 Thumbprint of the latest
GigaVUE-FM as the service manager so that GigaVUE-FM and VMware NSX-V can communicate with

each other. For instructions, refer to Configure IP Address of GigaVUE-FM as Service Manager for
VMware NSX-V.

The following figure illustrates the GigaVUE-FM migration process on VMware ESXi.

Existing GigaVUE-FM

1]
'g o
o &0 Deploy a new
Q.
o)

GigaVUE-FM Instance

e with Latest Version
GigaVUE-FM Instance

with Special m Migrate

Migration Version
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Migrate GigaVUE-FM on VMware ESXi

Before proceeding with the migration, ensure that you meet the recommended system
requirements and prerequisites. Refer to VMware Migration—System Requirements and
Prerequisites.
To migrate GigaVUE-FM on VMware ESX:i:

1. Log in to the special migration version of GigaVUE-FM.

2. On the right side of the top navigation bar, click the Admin drop-down list, and then select
Software Upgrade. The Software Upgrade Wizard appears.

@) GigaVUE-FM Dashboard Q A C £

" Change P. d
Profile: Default ange Passwort

Nov 15, 2019 19:51:01 Software Upgrade

Logout

Physical & Virtual

Highest Traffic: Stack Ports ] Lowest Traffic: Network Ports & Lowest Traff|

3. Ensure that you meet all the prerequisites listed on the Requirements screen of the Wizard.

Software Upgrade

Requirements

uctions, refer to the “Install GigaVUE-FM on Viware ESXi section in

4. Click Next. The Set Up Connection screen of the Software Upgrade Wizard appears.
5. Enter the IP Address or Hostname of the latest version of GigaVUE-FM.

6. Enter the login credentials such as the Username and Password, and then click Connect. The
connection is established between both the GigaVUE-FM instances.

7. Click Next. The Migration Data screen of the Software Upgrade Wizard appears.

8. Select the Data Files check box to migrate the statistics, events, audit logs, and syslogs. By
default, all the configuration files will be migrated.

9. Enter the number of days for which you want the data to be migrated. The estimated time for
migration appears in the Wizard.
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Software Upgrade

o o © ©

Migration Data
All your configuration files will be migrated.

Choose the number of days of data to migrate:

s include your GigaVUE-GS and GigaVUE-FM configurations al

19 Data Files
Data files include all statistics, events, syslogs, and app Intelligence data
Last 7 days
Must be between 125

| & Warning: Estimated time to migrate your files could take up to 102 minutes.

Figure 1  Estimated Migration Time

10. Click Next. The data migration process begins. All the files will be exported from the special
migration version of GigaVUE-FM and then imported to the latest version of GigaVUE-FM.

NoTE: The migration process will continue in the background even if you close the
browser. You can login again to check the migration status.

11. After the migration is complete, Click Finish.

Software Upgrade

REQUIREMENTS SET UP CONNECTION MIGRATION DATA IMPORT DATA

Migration

We are preparing to migrate your data to the new GigaVUE-FM.

Giga¥UE-FM 10.11554.75 GigaVUE-FM 10.115.54.78
Version 5.7.01.01 Version 5.8.00

M
~/

Prepare Migration - § of 8 files completed

+/ Configuration - 1 of 1 files completed;
+/ AuditLog - 1 of 1 files completed;

+/ Events - 1 of 1 files completed;

+/ Syslogs - 1 of 1 files completed;

 Statistics - 1 of 1 files completed;

© Export completed
\

&

Migration - 8 of & files completed

< Audit Log - 1 of 1 files completed;
+ Evers - 1 of 1 files completed;
o sysiogs - 1of 1 files completed;

 Statistics - 1 of 1 files completed;

(@) Import completed
\

+ Configuration - 1 of 1 files completed;

Figure 2  Migration Process Complete for VMware ESXi

After the migration is successful, you can decommission the GigaVUE-FM instance with the special

migration version.
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Configure IP Address of GigaVUE-FM as Service Manager for VMware NSX-V

GigaVUE-FM and VMware NSX-V communicate with each other using the GigaVUE-FM'’s IP address,
which acts as a service manager. When you migrate from the special migration version to the latest
version of GigaVUE-FM, the IP address that is configured as the Service Manager in VMware NSX-V
does not change. You must manually configure the IP address and SHA-1 Thumbprint of the latest
version GigaVUE-FM.

Before you proceed with the configuration, ensure that you meet the following prerequisites:
* You have decommissioned the GigaVUE-FM instance with the special migration version.

* You have made a note of the IP address and SHA-1 Thumbprint of the latest version of
GigaVUE-FM instance. You can get the IP address and SHA-1 Thumbprint from the About

GigaVUE-FM page. To access the About GigaVUE-FM page, click kid on the top navigation bar,
and then from the left navigation pane, select About.

@’a GigaVUE-FM Dashboard Physical Virtual Cloud

Q All Audit Logs

About GigaVUE-FM

IP Address 10.115.55.50 e

i= Tasks

E Reports

Netmask 255.255.248.0
2 Authenticat
HENERHCSHON Gateway 10.115.48.1
# High Availability DNS Server 10.10.1.20, 2001:10:10:1:20, 2001:10:10:1:22
NTP Server Not Available
FM Start-up 2019-11-13 12:42:32
Time
FM Uptime 2 days, 00 hours, 43 mins
Build ID #150804
) Build Date 2019-11-12
<> APl Reference
Boot Image Not Available
©® About 2
SHA-1 5e:7d:23:72:05:a0:22:b5:d3:8c:42:94:80:78:59:69:81:73:c1:7d e
Thumbprint
SHA-256 45:63:65:fc:8f:55:8¢:57:7e:1e:d8:dc:23:95:cc:d9:fc:05:5e:5f:al:7e:af:3e:b7:91:c6:2f:e5:8c:7e:35
Thumbprint

Figure 3  Accessing About GigaVUE-FM Page

To configure GigaVUE-FM IP address as Service Manager for VMware NSX-V:
1. Launch the VMware vSphere Web Client.
2. Go to Networking & Security > Service Definitions > Service Managers.

3. Select Gigamon Traffic Visibility Manager, and then click the Edit Service Manager icon. The
Edit Service Manager page appears.
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4. Inthe Administration URL and the Base APl URL fields, replace only the IP address with the
IP address of the latest version of GigaVUE-FM.
5. In the Thumbprint field, enter the SHA-1 Thumbprint of the latest version of GigaVUE-FM.
6. Click OK.

Edit Service Manager

()
)

Name: * Gigamon Traffic Visibility Manager
Description: Gigamon Traffic Visibility Manager

Administration URL:  https:/f10.115.55.50
Base API URL: https:/{10.115.55.50/api/0.9

Credentials

Name: admin
Password:

Retype Password:

Thumbprint: 5e:7d:23:72:05:a0:22:b5:d3:8¢:

42:94:80:78:59:69:81:73:¢1:7d

Vendor Details
Vendor ID: Gigamon
Vendor Name: Gigamon

[V Operational State

GigaVUE-FM Migration on Hardware Appliance

Use this option if you have a GigaVUE-FM Hardware Appliance running on GigaVUE-FM version 5.7
or lower that you want to migrate to the latest version of GigaVUE-FM.

NoTE: The migration process explained in this section is common for both GigaVUE-FM
Hardware Appliance and GigaVUE-FM Hardware Appliance 2.0.

GigaVUE-FM Hardware Appliance Migration—Rules and Notes

« Upgrade your GigaVUE-FM Hardware Appliance to the special migration version of GigaVUE-
FM, which provides the tools to manage and perform the migration.

NoTE: To obtain the required software images, register on the customer portal and
download the software.

* In GigaVUE-FM Hardware Appliance 2.0 running on GigaVUE-FM version 5.7 or lower, if 1
Gigabit interface is used as management port, the eth2 interface will be configured for DHCP.
However, when you migrate the GigaVUE-FM Hardware Appliance 2.0 to the latest GigaVUE-
FM version, the interface names will swap from eth2 to ethO for DHCP.
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« The GigaVUE-FM with special migration image is only to be used for migration to the latest
version of GigaVUE-FM. It is not intended for managing production nodes. Upgrades from
earlier GigaVUE-FM releases to the migration image must immediately be followed by an
upgrade to the latest version of GigaVUE-FM within the same maintenance window to avoid
any performance challenges.

GigaVUE-FM Hardware Appliance Specification

The following table provides the GigaVUE-FM Hardware Appliance specification:

Reference Gigamon iDRAC CPU RAM HDD/SSD
SKU
GigaVUE-FM GFM-HWO- R430 iDRACS8/7 | 12vCPU 16 GB 120 GB 4x1 GB
Hardware FMO10 and lower Primary (in Ethernet
Appliance RAID)
1.2TB
Secondary (in
RAID)
GigaVUE-FM GFM-HW1- R440 iDRAC9 32 vCPU 128 GB 240 GB + 2x1GB
Hardware FMO10 and above Primary (in Ethernet
Appliance 2.0 RAID) . 2x10GB
247TB Ethernet
Secondary (in
RAID)

Migration on Hardware Appliance—At-A-Glance

Step 1: Backup your data and configuration files from your GigaVUE-FM instance to an archive server.
For instructions on how to backup the data, refer to the “Backup Immediately” section in the
GigaVUE-OS and GigaVUE-FM Administration Guide.

Step 2: Upgrade your existing GigaVUE-FM instance to the special migration version. For details
about the supported special migration version and the upgrade path, refer to Supported Migration
and Upgrade Paths. For upgrade instructions, refer to Upgrade an Existing GigaVUE-FM Deployment.

Step 3: Log in to the special migration version of GigaVUE-FM and start the migration process.

Step 4: Install the GigaVUE-FM Hardware Appliance with the latest version of GigaVUE-FM using an
ISO file. For installation instructions, refer to the Migrate GigaVUE-FM Hardware Appliance.

NoTE: To obtain the required software images, register on the customer portal and
download the software.
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Step 5: After the latest version of GigaVUE-FM is installed, the restoration process gets triggered
automatically.

The following figure illustrates the migration process on the GigaVUE-FM Hardware Appliance.

GigaVUE-FM
Hardware Appliance
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All configuration files along with the
data files that you have chosen for
migration are migrated to the latest
version of GigaVUE-FM

Migrate GigaVUE-FM Hardware Appliance

Before proceeding with the migration, keep in mind the rules and notes listed in GigaVUE-FM
Hardware Appliance Migration—Rules and Notes

If you choose to set up the ISO image of the latest version of GigaVUE-FM using the automated
process:
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« Ensure that you have the login credentials of Integrated Dell Remote Access Controller (iDRAC)
that is managing the GigaVUE-FM Hardware Appliance.
« Download the ISO image of the latest version of GigaVUE-FM from the customer portal and
save it to your Remote File Sharing (RFS) server.
To migrate the GigaVUE-FM Hardware Appliance to the latest version of GigaVUE-FM:

1. Log in to the GigaVUE-FM Hardware Appliance running on the special migration version of
GigaVUE-FM.

2. On the right side of the top navigation bar, click the Admin drop-down list, and then select
Software Upgrade.

The Software Upgrade Wizard appears.

@ GlgaVUE—Fl\/I Dashboard

" Change P. d
Profile: Default ange Passwort

o Software Upgrade
Physical & Virtual Nov 15, 2019 19:51:01

Logout

Highest Traffic: Stack Ports & Lowest Traffic: Network Ports -] Lowest Traff|

3. Inthe Setup ISO Image screen of the Software Upgrade Wizard, choose one of the following
methods to set up the ISO image of the latest version of GigaVUE-FM:

« Manual—You must download the ISO image of GigaVUE-FM5.10.xx from the customer
portal. Mount the ISO image to your Hardware Appliance. The Hardware Appliance
reboots after the ISO image is loaded. For details, refer to Set Up the GigaVUE-FM ISO
Image Manually.

« Automatically—Set up the ISO image using an automated process.

Complete the following steps if you choose to set up the ISO image automatically:

a. Under the iDRAC section, enter the IP Address, Username, and Password for iDRAC that is
managing the GigaVUE-FM Hardware Appliance.

b. Under the RFS section, enter the IP Address, Username, and Password of the Remote File
Sharing server in which you have downloaded the ISO image of the latest version of
GigaVUE-FM.

c. Inthe ISO Image Path field, enter the absolute path of the ISO image.
d. From the Protocol drop-down list, select NFS or CIFS.

e. Click Connect.
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Software Upgrade

SETUP ISO IMAGE MIGRATION DATA PREPARE MIGRATION MIGRATION

Setup your newer version ISO file
Automatic ISO Setup
Ensure you have downloaded the ISO image file from the Customer Portal and placed it on your Remote File Server(RFS).

Provide the login credentials for your Integrated Dell Remote Access Controller (iDRAC) that is managing your GigaVUE-FM
Hardware Appliance and the RFS to which you have saved the downloaded 1SO image file.

iDRAC RFS

IP Address IP Address
Username Username
Password Password

1SO Image Path

Protocol

NFS v

CONNECT

4. In the Migration Data screen of the Software Upgrade Wizard, select the Data Files check box
to migrate the statistics, events, audit logs, and syslogs. By default, all the configuration files
will be migrated.

5. Enter the number of days for which you want the data to be migrated. By default, seven days
of data will be migrated.

6. Click Next. The data migration process begins. All the files will be converted to the format of
the latest version of GigaVUE-FM and will be restored on the Hardware Appliance.

Open a new tab and then log in to the latest version of GigaVUE-FM to check if the migration
process is completed.

Ensure that you change your password at your first login to GigaVUE-FM Shell. The password must
be a minimum of 14 characters in length and must include at least:

* One numerical character
 One upper case character
« One lower case character

« One special character

After you change your password, you will be logged out of GigaVUE-FM Shell from the current
session. You must log in again with your new password.
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Set Up the GigaVUE-FM ISO Image Manually

You can perform a manual installation of ISO image either from local file system or RFS server.
Before proceeding with the ISO installation, it is recommended that you set up the boot sequence in

the following order:

1. Hard disk

2. Physical DVD
3. Virtual DVD

Refer to the following table for details about how to install an ISO image using iDRAC:

Task

Set up the first boot
device

Description

Whether you choose to install the ISO image from local file
system or remote file sharing server, ensure that you set up
the first boot device in iDRAC.

« Select Virtual CD/DVD/ISO as the first boot device.
» Enable Boot Once.

Refer to:

"First Boot Device" section in the
Integrated Dell Remote Access
Controller Online Help.

NoOTE: Press the F1 key in the
iDRAC user interface to access
the Integrated Dell Remote
Access Controller Online Help.

Install the ISO image
from the local file
system

Before proceeding with the ISO installation, ensure that you
have downloaded the latest version of GigaVUE-FM ISO image
to your local file system. To obtain the required software
images, register on the customer portal and download the
software.

» Use the Map CD/DVD option to browse and select the ISO
image file that you have saved in your local file system.

« Use Power Cycle System (cold boot) to power cycle
GigaVUE-FM.

Wait for 30-45 minutes for the ISO image to install and the

data to be migrated.

NoTE: It may take 2 to 3 reboot cycles for the migration
process to be completed. After the migration process is
completed, you will see the GigaVUE-FM login prompt in
which the hostname of the GigaVUE-FM appears. You must
now disconnect the virtual media.

Using the Virtual Media function
on iDRACS6, 7, 8and 9

Install the ISO image
from remote file
sharing server

Before proceeding with the ISO installation, ensure that you
have downloaded the latest version of GigaVUE-FM ISO image
to a RFS server. To obtain the required software images,
register on the customer portal and download the software.

« Enter the absolute file path of the ISO image, domain
name, user name, and password of your NFS or CIFS server.
Examples of the file path format are as follows:

"Remote File Share" section in
the Integrated Dell Remote
Access Controller Online Help.

NoOTE: Press the F1 key in the
iDRAC user interface to access
the Integrated Dell Remote
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Task

Description

«  NFS—<nfs server IP>:<path> eg
10.70.10.70:/home/admin/gigavue-fm-5800.iso

e CIFS—\\<cifs server IP>\<path to iso> eg.
//10.70.10.10/Downloads/gigavue-fm-5800.iso

e HTTP— http://<URL>/<file path>/<image name>
eg. http://10.10.10.10/Downloads/gigavue-fm-
5800.iso

o HTTPS—https.//<URL>/<file path>/<image nhame>
eg. https://10.10.10.10/Downloads/gigavue-fm-
5800.is0

NoOTE: The http and https options are available only for
iDRAC 9 v3.00.00.00 and above.

« Use Power Cycle System (cold boot) to power cycle
GigaVUE-FM.

Wait for 30-45 minutes for the ISO image to install and the

data to be migrated.

Refer to:

Access Controller Online Help.

Install the ISO image
from USB

NoTE: This option is applicable only for GigaVUE-FM
Hardware Appliance 2.0 managed by iDRAC 9 v3.00.00.00
and above.

Before proceeding with the ISO installation, ensure that you
have downloaded the latest version of GigaVUE-FM ISO image
and copied it to a 8 GB USB using the dd command in Linux.

To obtain the required software images, register on the
customer portal and download the software.

"Management USB Settings"
section in the Integrated Dell
Remote Access Controller Online
Help.

NOTE: Press the F1 key in the
iDRAC user interface to access
the Integrated Dell Remote
Access Controller Online Help.

GigaVUE-FM Migration on AWS

Use this option if you want to migrate your GigaVUE-FM instance running on the AWS platform.

NoOTE: The migration process is applicable only if your current deployment has GigaVUE-FM
5.7. For deployments with GigaVUE-FM 5.6 or lower, you must deploy a fresh installation of
the latest version of GigaVUE-FM and create the configurations again.

Refer to the following sections for details:

Migration on AWS—At-a-Glance

Following is an at-a-glance view of the tasks that you must perform to migrate to the latest version

of GigaVUE-FM:

Migrate GigaVUE-FM
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Step 1: Stop the existing version of the GigaVUE-FM instance. Refer to Stop GigaVUE-FM FM
Instance.

Step 2: Create a snapshot of the second disk (dev/sdb) of the FM instance. Ensure to make a note of
the snapshot ID. Refer to Create Snapshot of the GigaVUE-FM Instance.

Step 3: Upgrade your GigaVUE-FM 5.7 instance to the special migration version of GigaVUE-FM. For
details about the supported special migration version and the upgrade path, refer to Supported
Migration and Upgrade Paths. For upgrade instructions, refer to Upgrade GigaVUE-FM Instance. To
get the software image, contact customer support.

Step 4: Launch the GigaVUE-FM instance with the special migration version. While launching the
instance, enter the snapshot ID of the old version of the GigaVUE-FM instance (that you have made a
note of in Step 2) in Add Storage > Add New Volume.

Step 5: Verify if the data from the previous GigaVUE-FM instance is restored in the new instance.
Ensure that you set up the same password that you used to access the old GigaVUE-FM instance.

Step 6: Initiate the migration process in the GigaVUE-FM instance with special migration version.
Refer to Migrate GigaVUE-FM on AWS.

Step 7: After the migration is complete, stop the GigaVUE-FM instance with special migration
version. Refer to Stop GigaVUE-FM FM Instance.

Step 8: Create a snapshot of the second disk (dev/sdb) of the GigaVUE-FM instance with special
migration version. Ensure to make a note of the snapshot ID. Refer to Create Snapshot of the
GigaVUE-FM Instance.

Step 9: Upgrade your GigaVUE-FM instance with special migration version to the latest version of
GigaVUE-FM. Refer to Upgrade GigaVUE-FM Instance. You can get the software image from AWS
Marketplace or Community AMIs.

Step 10: Launch the latest version of GigaVUE-FM. While launching the instance, enter the snapshot
ID of the GigaVUE-FM instance with special migration version (that you have made a note of in Step
8) in Add Storage > Add New Volume.

Step 11: Wait for about 10 minutes for the restore process to get completed before you login to the
latest version of GigaVUE-FM instance. Verify if the data from the GigaVUE-FM instance with special
migration version is restored in the GigaVUE-FM instance with the latest version. Ensure that you use
the same password that you used to access the old GigaVUE-FM instances.

Step 12: Terminate the old GigaVUE-FM and the GigaVUE-FM with the special migration version.

The following figure illustrates the GigaVUE-FM migration process on AWS.
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Existing GigaVUE-FM
For AWS Platform

Upgrade to GigaVUE-FM
with Special Migration

Version .
e Migrate

All Configurations and
data files are migrated

Stop GigaVUE-FM FM Instance

Before upgrading the GigaVUE-FM instance, the existing version of the GigaVUE-FM instance must
be stopped.

NoTEe: Do not terminate the GigaVUE-FM instance.

To stop the GigaVUE-FM instance:
1. Login to the AWS account and select Services > EC2.

2. Inthe left navigation pane, select Instances.
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Services v Resource Groups ~ % [\ gig-account-setup-GIGUserRole . v  Oregon »  Support »
EC2 Dashboard - Launch Instance Actions v o> B @
Events 1 e
Tags Q, Filter by tags and attributes or search by keywor e | 1to500f58 > >
Reports
Limits Name = | Instance ID = | Instance Type ~ Availability Zone ~ Instance State ~ | Status Checks -~ Alarm Status Public
demo-VSenesNode-1 1-0f3b835646d2i5117 md.large us-west-2b @ running & 22checks ...  None ] -
INSTANCES demo-SeriesController-1 i-092bbfeac 9d975f29 12 medium us-west-2b @ running & 22 checks ... Nane %
| demo-G-vTapController-1 1-079bb916fb80c5Td 12 medium us-west-2b > running & 212 checks .. None ‘,g
Spot Requests demo-FabricManager (frome...  i-03b2b34fdff5b33e8 12 large us-west-2b @ running & 2/2 checks ... Nene W o3
Reserved Instances tme-fm-VSeniesController-1 1-070c8a06c562ab420 12 medium us-west-2a @ running @ 212 checks . Nane % e
Scheduled Instances fm.GvTanControllar.d NeEAhdRI1hARRGedE 13 madinm 4
Dedicated Hosts Select an instance above N ==

3. Inthe search field, enter the name of the existing GigaVUE-FM instance and select the Instance
ID.

NoTE: If the instance ID is the password for logging in to the existing GigaVUE-FM, make
note of this instance ID. This instance ID will be used as the password for logging in to the
upgraded GigaVUE-FM as well. If the password is changed, use the changed password to
login to the upgraded GigaVUE-FM.

4. Go to Actions > Instance State > Stop.

Create Snapshot of the GigaVUE-FM Instance

You must create a snapshot of the volume of the existing version (dev/sdb) of the GigaVUE-FM
instance. Snapshots capture data that are written to your Amazon EBS volume at the time the
snapshot is taken. This excludes any data that are cached by any applications or the operating system.

To create a snapshot:

1. Select the GigaVUE-FM instance and click the Description tab.
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with the volume ID link.

- Support «

EC2 Dashboard
Events

Tags

Reports

Limits

| Instances
Spot Requests
Reserved Instances
Scheduled Instances
Dedicated Hosts

= IMAGH
AMIs

Bundle Tasks
ELASTIC BLOCK ¢
Volumes

Snapshots

Security Groups
Elastic IPs
Placement Groups

1

Q search : i-0234df%32cedbab3a

~ Instance ID e

i-0234df932cedbab3a 12 large

Termination protection

Lifecycle

Monitaring
Alarm status
Kemel ID

RAM disk ID
Flacement group
Vitualization
Reservation
AMI launch index
Tenancy

Host ID

Affinity

- State transition reason
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Instance Type ~

Actions ¥

Availability Zone ~

us-west-2a

man one nour)
False
normal

basic

None

m
r-0575065db97TcBeed
0

default

Instance State -

@ running

Block Device /devisdb

EBS ID
Root device type
Attachment time

Block device status

Delete on termination

Status Checks -

@ 22 checks...

o
1to10t1

Alarm Status Public DNS (IPv4) * IPv4 Public IP

None Y&  ec254-191-129-10.us-.. 54.191.129.10

Root device

Block devices

vol-0304e1c53baefdd17
EBS

2017-02-
06T21:21:15.0002
attached

True

In the Block Device dialog box, click the volume ID link. The Volumes page is displayed.
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Q search : vol-0304e1c53baef0d17

@ Name + \VolumelD ~ Size ~  \Volume Type ~ I0PS -
- vol-0304etc... 30 GiB gp2 100 / 3000
Volumes: | vol-0304e1c53baef0d17
Description Status Checks Monitoring Tags
Volume ID  vol-0304e1c53baef0d17
Size 30GIB
Created  February 6. 2017 at 1:21:14 PM UTC-8
State  in-use

Attac hment information

i-0234df932cedba53a (nikhil-fm-3.5-
upgrade-test) /dev/sdb (attached)

Snapshot = Created

February 6. 2017 at...

Alarm status
Snapshot
Awvailability Zone
Encrypted

KMS Key ID

e

+ Availability Zone -

us-west-2a

None

us-west-2a

Not Encrypted

Volume type  gp2 KMS Key Aliases
Product codes KMS Key ARN
IOPS 100/ 3000
5. Click Actions and select Create Snapshot.
. ey — ——
P ==0
i sy
The Create Snapshot page appears.
Q| search : vol-0304e1c53baef0d17 Add filte e
[ ] Name * VolumelD ~ Size ~  Volume Type - I0PS ~  Snapshot ~ Created + Availability Zone ~
- vol-0304elc . 30 GiB agp2 100/ 3000 February 6, 2017 at__ us-west-23
Volumes: | vol-0304e1c53baef0d17
Description Status Checks IMonitoring Tags
Volume ID vol-0304e1c53baef0d17 Alarm status ~ None
Size Create Snapshot o el
Created [Zone us-west-2a
State Volume (i)  vol-0304e1c53baef0d17 pted  Not Encrypted
Attachment information Name (j) fm-3 5.upgrade-snapshol-0208 | by ID
Description (i) [Snapsnui of the data volume for FM|3.5 ]
Wolume type Encrypted (7) No ases
Product codes ARN
I0PS

6. Enter the description of the snapshot.

7. Click Add Tag to add the required key and value.

8. Click Create Snapshot. It will take several minutes for the snapshot to be created.
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State

@ in-use

1to10f1

State

@ in-use
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Ovmed By Me w () | search : snap-05e471660db347¢c 12 Add filter

B HName + Spapshot 1D = | Size + Description

B nkhi-m-35..  snap05e4T1660db3... 30 GiB Snapshot of the Data Volume of FM 3.5 instance

Snapshot: snap-05e4716860db947¢1e (nikhil-fm-2.5-upgrade-test-snapshot)

Description Permissions Tags

Snapshot ID snap-05e471660db%d7¢ 1e Progress
Status  complefed Capacity
Volume  vol-0304e1c53baef0d17 Encrypted
Started  February 6, 2017 at 1:39:37 PM UTC-8 KMS Key ID
Cramer 244915184467 KMS Key Aliases
Product codes  Loading... KMS Key ARN

Description  Snapshot of the Data Volume of FM 3.5
instance

2]

- Status

@ completed

100%
30 GiB
Mot Encrypted

£ £ 1to10f1

= Started

February 6, 2017

and add the volume while upgrading the GigaVUE-FM instance.

NoTE: Make a note of the snapshot ID. This snapshot ID will be used to find the snapshot

Upgrade GigaVUE-FM Instance

While upgrading the GigaVUE-FM instance, the Amazon EBS volume must be restored with the data
from the snapshot that is created in Create Snapshot of the GigaVUE-FM Instance.

To upgrade the GigaVUE-FM instance:

1. Select Services > EC2.

2. Click Launchinstance and go to AWS Marketplace or Community AMls.

contact customer support.

NoTE: The software image of the GigaVUE-FM with special migration version will not
be available in the AWS Marketplace or Community AMIs. To get the software image,

3. Search for Gigamon, locate the latest version of the GigaVUE-FM AMI, and click Select.

4. Choose the Instance Type. The recommended instance type is m4.xlarge.

NoTE: Do not select the t2 instance types as they are not supported.

5. Click Next:Configure Instance Details.

Migrate GigaVUE-FM
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1. Choose AMI 2. Choose Instance Type 3. Configure Instance 4 Add Storage 5. Tag Instance 6. Configure Security Group 7. Review

Step 3: Configure Instance Details

Configure the instance to suit your requirements. You can launch multiple instances from the same AMI, request Spot instances to take advantag

Number of instances () |1 Launch into Auto Scaling Group (7)
Purchasing option (i) ) Request Spot instances
Network (i) [vpc-749b610 (10.0.0.0/16) | VPC-Alan v| C create newVPC
Subnet (j) |Subnet-fmcbca8(10_0_0_0f24) | SubnetMgmt | us-we ¥ | Create new subnet

245 IP Addresses available

Auto-assign Public IP () Use subnet setting (Enable) v
Use subnet setting (Enable)

Placement group (j)
Disable !

IAMrole (i) [None v| C Ccreate new 1AM role

6. Enter the following information.

* Network— Select the VPC where you want to launch the AMI.
+ Subnet— Select the management subnet that the instance will use after launch.

(Required)
 Auto-assign Public IP— Select Enable.
« 1AM role—Select an existing IAM role to associate with the instance. Refer to the GigaVUE

Cloud Suite for AWS Quick Start Guide.
7. Click Next: Add Storage and click Add New Volume.

Volume Type (i) Device (i)  Snapshot (i) Size (GIB) (i)  Volume Type (i) 10PS (1) rmh;:jgt%m Dle:“! SHEEnation E"i.“yp"“
snap-

Root fdev/sdal 40 General Purpose SSD (GP2) v 12073000 NA Gl Not Encrypted
061984458¢42353930

E8S v [idewisdb v|  [snap-Dsed71660008] (40 General Purpose SSO (GP2) v 10073000 N/A e o

Snapshot ID

Description

Add New Volume
snap-05e47166.

Snapshet of the Data Volume of FM 3.5 instance

Free tier eligible customers can get up to 30 GB of EBS General Purpose (SSD) or Magnetic storage. Learn more about free usage tier eligibility and

usage resfrictions

Cancel Previous Review and Launch Next: Add Tags

8. Enter the following storage device settings:
« Snapshot—Enter the name of the snapshot that is created in step 6 in the section Create

Snapshot of the GigaVUE-FM Instance.
« Size (GiB)— Enter the storage size of the volume.
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NoTe: When upgrading from your current version of GigaVUE-FM to the special
migration version of GigaVUE-FM, ensure that the size of the volume is double the
volume selected while launching the current version of the GigaVUE-FM instance.

However, when you upgrade from the special migration version to the latest version
of GigaVUE-FM, ensure that the size of the volume is same as the volume selected
while launching the special migration version.

« Volume Type— Select a volume type. The recommended volume is General Purpose SSD
(GP2).

» Delete on Termination—Select this check box to make sure the volumes are cleaned up
when the GigaVUE-FM instance is removed.

9. Click Next: Tag Instance, and then add a key-value pair to identify the instance.

1. Choose AMI 2. Choose Instance Type 3. Configure Instance 4. Add Storage 5. Tag Instance 6. Configure Security Group 7. Review

Step 5: Tag Instance

Atag consists of a case-sensitive key-value pair. For example, you could define a tag with key = Name and value = Webserver. Learn more aboutt

Key (127 characters maximum) Value (255 characters maximum)
[Name | |Gigamon Fabric Manager 1
Create Tag (Up to 50 tags maximum)

10. Click Next: Add Security Group. Click the Select an existing security group check box if the
security group is already created. Otherwise, select the Create a new security group check
box and click Add Rule. For more information on creating a security group, refer to the
GigaVUE Cloud Suite for AWS Quick Start Guide.

11. Click Review and Launch. Review the instance launch details and click Launch.

12. Select the SSH key pair, check the acknowledgment check box, and click Launch Instances.
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Select an existing key pair or create a new key pair X

A key pair consists of a public key that AWS stores, and a private key file that you store. Together,
they allow you to connect to your instance securely. For Windows AMIs, the private key file is required
to obtain the password used to log into your instance. For Linux AMIs, the private key file allows you to
securely SSH into your instance.

Note: The selected key pair will be added to the set of keys authorized for this instance. Learn more
about removing existing key pairs from a public AMI.

Cheoose an existing key pair
Select a key pair
evan-aws

| acknowledge that | have access to the selected private key file (evan-aws.pem), and that

without this file, | won't be able to log into my instance.
Cancel [ETELEED ]

13. It will take several minutes for the instance to initialize. After the initialization is completed,
verify the instance through the Web interface as follows:

a. Find the instance and expand the page in the Descriptions tab to view the instance
information, if necessary.

b. Copy the Public DNS value and paste the value into a new browser window or tab.

c. Copy the Instance ID of the previous version of the GigaVUE-FM. If the password is
changed, use the changed password to login to the upgraded GigaVUE-FM.

NoTE: Do not have multiple versions of GigaVUE-FM instances monitoring the same AWS
connection.

Migrate GigaVUE-FM on AWS

Before proceeding with the migration, ensure that you meet the following prerequisites:

* Ensure that you have upgraded your current GigaVUE-FM instance to the special migration
version. For details about the supported special migration version and the upgrade path, refer
to Supported Migration and Upgrade Paths.

NoTE: To obtain the required software images, contact customer support.

To migrate using this option:
1. Log in to the special migration version of GigaVUE-FM.

2. On the right side of the top navigation bar, click the Admin drop-down list, and then select
Software Upgrade. The Software Upgrade Wizard appears.
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@ GlgaVUE-Fl\/I Dashboard

Change Password

Profile: Default

Nov 15, 2019 19:51:01 Software Upgrade

Logout

Physical & Virtual

Highest Traffic: Stack Ports & Lowest Traffic: Network Ports -] Lowest Traff|

3. Inthe Migration Datascreen of the Wizard, select the Data Files check box to migrate the
statistics, events, audit logs, and syslogs. By default, all the configuration files will be migrated.

4. Enter the number of days for which you want the data to be migrated.

5. Click Next. The Migration process begins. The Migration Data screen displays the estimated
migration time for the specified number of days of data. All the selected data files along with
the configuration files will be exported. This may take several minutes.

6. After the export is complete, you must upgrade the GigaVUE-FM instance to the latest version
to complete the migration.

For information about how to upgrade GigaVUE-FM in AWS, refer to Upgrade GigaVUE-FM
Instance.

<Back Software Upgrade

Migration

to migrate your data to the new GigaVUE-FM.

Prepare Migration - 14 of 14 files
completed

@ Export completed

Your data export has been completed. To complete the migration, please follow the regular steps and upgrade to the 5,8.00 version
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Upgrade GigaVUE-FM

Starting with release 5.8.00, GigaVUE-FM introduces several significant changes, which include
improvements in usability and performance. These changes include upgrading and replacing
databases and changing the underlying operating system. So, you must migrate your existing
configurations and data such as audit logs, events, syslogs, and statistics from your current
GigaVUE-FM version (either 5.7 or lower) to GigaVUE-FM5.10.xx. You cannot directly upgrade
your GigaVUE-FM instance to release 5.10.xx. You must first upgrade to GigaVUE-FM5.7.02.21, a
special release that provides the tools to manage and perform the migration. You can then
upgrade to GigaVUE-FM5.10.xx. For instructions, refer to Migrate GigaVUE-FM .

This section describes how to upgrade GigaVUE-FM to the latest revision in either a VMware ESXi
host or in Microsoft HyperV environment. Starting with release 3.1, Gigamon supports KVM
environments. Previous versions of GigaVUE-FM have not been tested in the KVM environment.

NoTE: To upgrade software on H Series or TA Series nodes, refer to the “Upgrading Software
on a GigaVUE-FM Node or a Cluster from GigaVUE-FM" section in the GigaVUE-FM User’s
Guide.

Refer to the following sections for details:

« Upgrade an Existing GigaVUE-FM Deployment, which describes the overall upgrade path from
an existing GigaVUE-FM deployment.

« How to Use the Snapshot Feature, which describes how to upgrade GigaVUE-FM 3.1 and above
to the current version of GigaVUE-FM.

Upgrade an Existing GigaVUE-FM Deployment

Before starting an upgrade to GigaVUE-FM version, be sure to get the latest image, upgrade
information, and release notes from the customer portal. Be sure to review the release notes for the
latest release prior to upgrading your instance of GigaVUE-FM.

Once the GigaVUE-FM image is obtained, download it to a server within your environment from
which the current instance of GigaVUE-FM can upload it. It is important to save your current running
configuration using the facilities provided by the hypervisor before upgrading.
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NoTe: When upgrading from any version of GigaVUE-FM lower than 5.4.00, be aware of the
minimum memory requirements in the new release. Earlier releases specified 4GB of
memory for the OVA template; whereas versions after 5.4.00 require 8GB. If the existing
virtual or physical hardware running GigaVUE-FM is configured with less memory than
required, then increase the amount of memory available to the GigaVUE-FM machine.

Ensure that GigaVUE-FM time is set correctly to ensure accuracy of the trending data that is captured.

You can upgrade the existing deployment of GigaVUE-FM either from the CLI or from the GigaVUE-
FM UL

NoTe: When upgrading GigaVUE-FM, you must also upgrade GigaVUE-VM. For the steps to
upgrade GigaVUE-VM, refer to the "Bulk Upgrading GigaVUE-VM Nodes” section in the
GigaVUE Cloud Suite for VMware Configuration Guide.

Upgrade from CLI

There are five steps on how to upgrade an existing GigaVUE-FM deployment to the current release.

1. Verify that less than two images are present on the GigaVUE-FM server.

2. Download the new image into GigaVUE-FM using either HTTP, HTTPS, FTP, TFTP, SCP, or SFTP.
3. Install the new image.
4. Change boot partition.
5. Reboot GigaVUE-FM.
Notes:

« It is important to log in with the admin account/username when upgrading the image on the
existing GigaVUE-FM.

« GigaVUE-FM 3.2 and higher versions compute node health status differently than previous
versions. After the upgrade completes, rediscover the nodes to recompute node health status.

* Prior to GigaVUE-FM 3.2, backup files for physical nodes were in a binary format. Starting with
GigaVUE-FM 3.2, backup and restore files use a text based format and binary backup or restore
on physical nodes is not supported. When upgrading from a version lower than version 3.2,
backup your configuration prior to upgrading to the current version of GigaVUE-FM if you
desire, but the files will be in a binary format. Existing binary backups are not visible to
GigaVUE-FM. For binary backups, you must back up the node using the CLI commands rather
than GigaVUE-FM. For more information about the CLI commands, refer to the GigaVUE-OS-
CLI Reference Guide.

« When using the Firefox or IE browser, clear the cache before upgrading to prevent issues with
the browser.
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Step 1: Verify that only two images are present on GigaVUE-FM server

NoOTE: It is important that you log in with the admin account/username when upgrading the
image on the existing GigaVUE-FM.

1. To begin an upgrade, open a SSH session or console session within the vSphere Client, and
log int o GigaVUE-FM and change to configure mode, by entering the following on the
command line:

a. Type en <Enter> to switch to Enable mode.

The system prompt changes from [hostname] > to [hostname] #.
b. Type config t <Enter> to switch to Configure mode.

The system prompt changes from [hostname] # to
[hostname] (config) #

Figure 1Console Login to vSphere Clientshows an example of the login console.

2. Check the number of images currently available for installation with the following command
from the GigaVUE-FM CLI:

(config) # show images

Important: If there are more than two images listed in the Images available to be installed
section of the show images output, Gigamon recommends that you use the image delete
command to remove existing images until the system has only a single image. Both GigaVUE-
FM and GigaVUE-VM will display a warning if you attempt to fetch a third image.

3. To delete an existing image from the server use the following command:

(config) # image delete fma3300.img

4. Go to Step 2: Fetch the latest release of GigaVUE-FM.
) Iocalhost - vSphere Client ﬂg

File Edit View Inventory Adminstration Plug-ins Help
B Bl & vome » g0 inventory b BJ) Hosts and Clusters
"N GDeER D

B

5 locaihost GRAVUE-FM
Getting Started | Summary Resowrce Allocation ' Performance  Tasks &Events ' Alams [IXETRRY, Permissions  METN

3 [l Blades_dc
Bladed_Cluster
= @ 192.168.51.69
| & Appswr
@ Appsw2
@ oesr1
) DBsw2
B | Gigavue-FM
B VMware vCenter Se

1. = ol m v

|| Recent Tasks Name. Targel or Status contsins: = Clear X
I Name Target Ratus Details Tnitiated by wCenter Server Requested Start Tl — | Start Time
|
I 59 Tasks @ Marms To release cursor, press CTRLALT roct
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Figure 1  Console Login to vSphere Client

Step 2: Fetch the latest release of GigaVUE-FM

Gigamon provides an FTP site where the new release image file resides. To fetch the latest release,
do the following:

1. Locate the image file for the new release. Image files are named using a fmaxxxx.img format.
The xxxx indicates the version and build number (for example, fma3500.img for the v3.5
release).

2. Copy the image to your file server.

3. Use the image fetch command to retrieve the software image from your file server. The CLI
shows you the progress of the image fetch with a series of hash marks, returning you to the
system prompt when complete.

Note: The image fetch command supports the use of HTTP, HTTPS, FTP, TFTP, SCP, or SFTP
for the transfer of images.

a. The following command uses SCP to retrieve the fma3500 image from the image server
with the IP address of 10.115.0.100 using login and password.
(config) # image fetch scp://user:password@10.115.0.100/£fma3500.img

b. The following command uses FTP to retrieve the same image using login and password as
well.
(config) # image fetch ftp://user:password@10.115.0.100/£fma3500.img

c. The following command uses TFTP to retrieve the same image without using a password
but using a DNS server instead of an IP address for the download server.

(config) # image fetch tftp://myserver.gigamon.com/tftpboot/fma3500.img

Ensure that you specify the base directory when using TFTP

NoTE: Fetching the image using TFTP is time consuming, due to the size of the image
and the inherent slowness of TFTP. For better performance, use SCP or HTTP to fetch
the image.

4. Go to Step 3: Install the latest release of the GigaVUE-FM.

Step 3: Install the latest release of the GigaVUE-FM

Use the image install command to install the downloaded image file. When running the following
command, the process will first verify that the filename used for the image is suitable for installation
prior to installing the image. For example, to install the image downloaded in the previous step:

(config) # image install fma3400.img
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Step 4: Change the boot partition

Set the image you just installed to boot next with the following command. This ensures that at the
next boot the latest image will be picked up.

(config) # image boot next

Step 5: Reboot

The following command shuts down the current instance of GigaVUE-FM and reloads. If Step 4 is
performed, upon reboot, the new image is used.

(config) # reload

Step 6: Upgrade GigaVUE-VM

After upgrading GigaVUE-FM, you must also upgrade any deployed GigaVUE-FM-VMs. Otherwise,
maps may not work and the GigaVUE-FM-VMs will be unreachable. For information about upgrading
GigaVUE-FM-VM, refer to the “Bulk Upgrading GigaVUE-VM Nodes” section in the GigaVUE Cloud
Suite for VMware Configuration Guide.

Upgrade from GigaVUE-FM Ul

This section describes the steps to upgrade GigaVUE-FM from the Ul. You can upgrade by using an
image that is located on an external image server, or you can use GigaVUE-FM as the image server.

Keep in mind the following rules and notes before you upgrade GigaVUE-FM from the Ul:

« When using the GigaVUE-FM Ul to upgrade GigaVUE-FM, you can only upgrade to the currently
available version or to the next version. You cannot downgrade.

« When using the Firefox browser, clear the cache before upgrading to prevent issues with the
browser.

Upgrade from External Image Server

This section provides the steps for upgrading the GigaVUE-FM from an image stored on an external
server. The image can be transferred from the server to the GigaVUE-FM using either SCP or TFTP file
protocols.
To upgrade with an image stored on an external image server, do the following:

1. Upload the image to the external image server to make it available to GigaVUE-FM.

To obtain software images, register on the customer portal and download the software. To
reach the customer portal, go to https://gigamoncp.force.com/gigamoncp/.
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2. Add the image server to GigaVUE-FM. This stores the credentials, image file name, and IP
address of the server on GigaVUE-FM.

To add the image server:

a. In GigaVUE-FM, cIick on the top navigation bar.

b. Select System on the left navigation panel and go to Images > External Servers. The
External Servers page appears.

c. Click Add. The Add External Server page displays as shown in Upgrade from GigaVUE-FM
ul

d. On the Images Server page, specify the following:

« Analias to help identify the image server.

 The host IP address of the server.

« The protocol to use for the download: SCP or TFTP.

« The user name and password if you selected SCP. They are not needed for TFTP.

e. Click Save.

The External Server page displays the newly added external server. From the Admin drop-
down list in the top right corner of the window, select Upgrade to open the FM Image
Upgrade page as shown in the following figure.

Software Upgrade

Image File

Select the file server where you have uploaded the image file.

Image Server: NewExternalServer '

Image File Path: f=image path=/<image name=

To monitor the progress and status of the upgrade, cIick “GigaVUE-OS and GigaVUE-FM
Administration Guide”.

3. Onthe FM Image Upgrade page, click on the Image Server field and select the server added in
Step 2.

4. Inthe Image File Path, enter the image path and filename on the external file server.

5. Upgrade any deployed GigaVUE-FM-VMs.
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After upgrading GigaVUE-FM, you must also upgrade any deployed GigaVUE-FM-VMs.
Otherwise, maps may not work and the GigaVUE-FM-VMs will be unreachable. For information
about upgrading GigaVUE-FM-VM, refer to the “Bulk Upgrading GigaVUE-VM Nodes” section in
the GigaVUE Cloud Suite for VMware Configuration Guide.

Upgrade with GigaVUE-FM as the Image Server

This section provides the steps for upgrading GigaVUE-FM when GigaVUE-FM is used as the file
server instead of an external server.

Upgrading from GigaVUE-FM 5.6.01 to 5.7.xx.00 or 5.7.01 via an internal image will not work because
internal server storage does not function during the upgrade procedure.

Alternatively, you can upgrade using an external image server or the GigaVUE-FM CLI or you can use
the GigaVUE-FM internal storage to store the GigaVUE-FM image, and point to it as if it were an
external server as follows :

1. Add the GigaVUE-FM 5.7 image under the GigaVUE-FM internal image server
(/config/gigamon/imagesRepo).

2. Configure the GigaVUE-FM external server with the GigaVUE-FM IP address.

3. Initiate the upgrade process, select External Image Server, and then specify the path to the
GigaVUE-FM Image file that you added in step 1
(/config/gigamon/imagesRepo/fma5700.img).

To upgrade a GigaVUE-FM using internal image files, do the following:

1. Download the images from the Gigamon website and place them where they can be available
for uploading to GigaVUE-FM.

To obtain software images, register on the customer portal and download the software. To
reach the customer portal, go to https://gigamoncp.force.com/gigamoncp/.

2. Upload the images file to GigaVUE-FM.
a. Click on the top navigation bar. In the left navigation panel, go to System > Images >
Internal Image Files.
b. On the Internal Image File page, click Upload.
c. Click Browse to locate the image file.
d. Click OK to upload the file. The page displays the progress of the upload.

After the upload completes, you can see the GigaVUE-FM image to use for the upgrade on the
Internal Images Files page.

3. Click the Admin drop-down list on the top right of the window and select Upgrade.
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4. On the FM Image Upgrade page, click in the Image Server field and select Internal Image
Server.

5.

Software Upgrade

Image File

Select the file server where you have uploaded the image file.

Image Server: Internal Image Server v
Version: v}
|
Image File:

From the Version drop-down list, select the version to which you are upgrading.

NoTE: You can only upgrade to another instance of the current version or the
immediate next version. Downgrading to a lower version is not supported through the
ul.

Click Upgrade.

NoTe: When you change the IP address of the GigaVUE-FM instance using the jump-
start configuration, the internal database and the in-memory caches of the GigaVUE-
FM instance are not updated. The Database continues to have the IP address of the old
GigaVUE-FM, and the image upgrade using the internal server option does not work.
To fix this, you must restart the GigaVUE-FM instance after upgrade.

To monitor the progress and status of the upgrade, click ki on the top navigation bar and
select Events on the left navigation pane. Also, email notifications are sent if email
notifications have been configured.

After upgrading GigaVUE-FM, you must also upgrade any deployed GigaVUE-FM-VMs.

Otherwise, maps may not work and the GigaVUE-FM-VMs will be unreachable. For information
about upgrading GigaVUE-FM, refer to the "Bulk Upgrading GigaVUE-VM Nodes” section in the

GigaVUE Cloud Suite for VMware Configuration Guide.

NorTeE: If you are using FireFox, clear the cache before upgrading to prevent issues with the

browser.

Upgrade GigaVUE-FM
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How to Use the Snapshot Feature

This procedure is only valid for upgrading from GigaVUE-FM v3.0 and above. For upgrades from
pre-3.0 releases, review the GigaVUE-FM v3.0 User's Guide and upgrade to release GigaVUE-FM v3.1.
Then follow the steps below to upgrade to the current release version of GigaVUE-FM.

NoOTE: You cannot directly upgrade from a pre-3.3 releases to the current release. You can
only upgrade from GigaVUE-FM v3.3 or v3.4 release.

1.

Prior to upgrading, ensure that the available memory size is at least 8GB prior to upgrading
to the new GigaVUE-FM release. If the available memory size is less than 8GB, it will cause out

of memory issues. Also, at least 2 vCPU are required.

When upgrading from v3.1, it's a good idea to use the vSphere client's Snapshot feature to
record the current state of the GigaVUE-FM virtual machine. Steps to use Snapshot feature are

as follows:

a. Log into the vSphere client and navigate to the Datacenter or Cluster level where the
GigaVUE-FM installation is located.

b. Right-click the GigaVUE-FM entry in the vSphere client and select the Take Snapshot

option.

<4 VCBA W “ (1 GigaVUE-FM22 | Actions

il
I(

{p Actions - Giga/UE-FM22

jetting Started | Summary  Monitor  Manage

Related Objects

Q o (<]
8 | Poweron What s a Virtual Machine?
~ [ ShutDown Guest0S Avirtual machine is a software computer that,
3 Restart Guest 08 like a physical computer, runs an operating
. system and applications. An operating Virtual Machines
Gh Migrate.. system installed on avirtual machine is
@ Take Snapshot... called a guest operating system.
iy Revertto Latest Snapshot Because every virtual machine is an isolated Cluster |55
[@ IManage Snapshots computing environment, you can use virtual
machines as deskiop or workstation
8 Clone to Virtual Machine... environments, as testing environments, or to
gF Clone to Template... consolidate server applications. Host
e Edit Settings In vCenter Server, vifual machines run on
hosts or clusters. The same hostcan run .
Wave To.. many virtual machines B e
\r Datacenter
Rename... % vCenter Server
@" Assign Tag vSphere Client
< Remove Tag
Alarms
AllvCenter Actions Basic Tasks Explore Further
> Power on the virtual machine Learn how to install a guest
| Power off the virtual machine operating system
Il Suspend the virtual machine Learn more about virtual machines
& Edit virtual machine settings Learn about templates
Figure 2  “Take Snapshot” Command to Preserve Current Settings Prior to Upgrade
M I
c. Follow the system prompts to record a snapshot of GigaVUE-FM's current state.
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4 vCenter Servers SRCIR

3 vCSA ‘ Actions ~

Gefting Started  Summary  Monitor  Manage | Related Objects |

Related Commands

This section describes the related commands for GigaVUE-FM.

fmctl

Use the fmctl command to manage GigaVUE-FM-related configurations.

The fmctl command has the following syntax:

fmctl

image

fetch <download URI> [<filename>]

list [details] [<filename>]

install <filename> [next|location {1]|2}]
boot [next|location {1]|2}]

delete [force] <filename>

{move|rename} <old filename> <new filename>

show

jump-start

Related Commands

fmctl

configuration [backup|restore][<absolute pathname of backup file>]

£ Top Level Objects [ 2]
Datacenters @3 | [ | TopLevel Objects | Datacenters | Clusters | Hosts [Virual Machines | vi Templates | vapps | Datastores | Datastore Clusters | Standard Networ v »
Clusters - —
9 o | B & o | GhActions - & (q Filter -
Hosts
El m Name 1 a State Status Provisioned Space Used Space Host CPU Host Mem Gue
Virtual Machines
& - G, GigaVUE-FI21 Powered y ) 628 GB 0 MHz ouB
Vi Templatss [ 0] & Actions - GigaVUE-FM21
G GigaVUE-FI22 Powered 153 GB 0 MHz 0 MB
6 vapps - & VHD-51 Powered OF | poue; o 38 GB 0 MHz 0B
B patastores 6] G, VHD4-50 Powered D* Shut Down Guesl 05 | 281 GB 0 MHz W
9 Datastore Clusters 0] G, Vhware vCenter Server Appliance Powsrsd Of [y Restart Guest 08 3 15.00 GB 0 MHz oMB
€ standard Netwaorks [ 2] ‘ & Migrate |
&= Distributed Switches [0 i Take Snapshot...
2 Distributed Port Groups [ ‘ Revert to Latest Snapshot |
& Extensions m @ Manage Snapshots
‘ a& Clone to Virtual Machine.. |
55 Clone to Template...
‘@ Edit Settings.. |
Move To..
‘ Rename... Power » Power On
& Assign Tag... Guest 05 [ — Power OFf
‘Q Remove Tag Snapshots » [0 Suspend
Alarms » & Migrate. &) Resat
‘ AllvCenter Aclions 1 gﬁ" Clone to Virtual Machine... Shut Down Guest QS
55 Clone to Template... @ Restart Guest 0S5
‘ Convert to Template
Figure 3  Power Off Command
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logging [<fqdn>[:<port>]] [facility <facility>] [priority <priority>] [udp|tcp]
no logging <fqdn>[:<port>]
reset factory halt

set Ul admin password <new password>

{get|show} interface [[mgmt|management}]
set interface {mgmt|management} <interface name>
[options{--help|--interface <interface name>}]
set mapping <fqdn> <IP address>
{get|show} {ip|ntp|hostname|domain|fqdn}
set [ip|ip6] dhcp
set [ip|ip6] [static] <address/cidr> <gateway> <dns1>[,<dns2>[,...]
set {ip|ip6} route {add|remove} address/cidr gateway
set ntp {disable|[enable] <server1>[,<server2>[,...]}
set hostname <hostname>
set domain <domain>
set fqdn <hostname> <domain>
set/get/show searchdomains [<domain1>[,<domain2>][,...]1]
set/get/show nameservers [<dns1>[,<dns2>[,...]11]

show backup [<absolute pathname of backup file>]

The following table describes the arguments for the fmetl command:

Argument Description

configuration [backup|restore] Backs up and restores the configurations such as
management interface, hostname, domain, IP, search
domains, and NTP.

For example, use the following command to back up the
system configurations:
fmctl configuration backup <absolute
path name of backup file>
Use the following command to restore the system
configurations from the backup:

fmctl configuration restore <absolute
path name of backup file>

image fetch <download URI> Retrieves a saved configuration file from a remote host.
[<filename>] Use HTTP(S), FTP, TFTP, or SCP to retrieve the file. The
format for the download URL is as follows:

[protocol]://username
[:password]@hostname/path/filename

For example, the following command retrieves the
configuration file named myconfig from the FTP server
at 192.168.1.10 using the robh account with the xray
password:

fmctl image fetch

Related Commands
fmctl
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Argument Description

ftp://robh:xray@192.168.1.10/myconfig

You can also use the <filename> argument to give the
retrieved file a new name on the GigaVUE-FM H Series
node. For example, the following command retrieves
myconfig and names it newconfig on the node:

fmctl image fetch
scp://bbochy:catch1@192.168.1.75/myconfig
newconfig

NOTE: You cannot retrieve a file with the same name
as the currently active configuration file.

image list

Provides the list of image file names available in
GigaVUE-FM.

For example:

fmctl image list

image install <filename> [next|location

{1121

Installs the image file.

For example, use the following command to install the
image file on the next partition:
fmctl image install gigamon-gigavue-fm-
5.8.00-160194-trial.img next
Use the following command to install the image file on
the specified partition:
fmctl image install gigamon-gigavue-fm-
5.8.00-160194-trial.img location 1

NoTE: Ensure that your current partition is not the
same as the partition you specified for installation.
Else, an error is displayed.

image boot [next|location {1]2}]

Boots the image file on the specified partition. Ensure
that the partition has the installed image file.

For example, use the following command to boot the
image file on the next partition:

fmctl image boot next

Use the folloaing command to boot the image file on the
specified partition:
fmctl image boot location 1

NoTE: GigaVUE-FM reboots immediately.

image delete [force] <filename>

Deletes the named image file.
For example:

fmctl image delete myimage

image {move|rename} <old filename>
<new filename>

Moves or renames the specified image file. For example,
the following command renames myimage as newimage:

Related Commands
fmctl
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Argument Description

fmctl image rename myimage newimage

image show

Displays the last boot partition.
For example:
fmctl image show

jump-start

Runs the configuration wizard for the initial setup of
GigaVUE-FM. Refer to Perform Initial Configuration.

NoTe: When you change the IP address of the
GigaVUE-FM instance using the jump-start
configuration, the internal database and the in-
memory caches of the GigaVUE-FM instance are not
updated. The Database continues to have the IP
address of the old GigaVUE-FM, and the image
upgrade using the internal server option does not
work. To fix this, you must restart the GigaVUE-FM
instance after upgrade.

logging [<fqdn>[:<port>]] [facility
<facility>] [priority <priority>]
[udp|tcp]

Configures the logging server.
For example:

fmctl logging 1.2.3.4:9514 facility *
priority debug tcp

no logging <fqdn>[:<port>]

Removes the logging server configuration.
For example:
fmctl no logging 1.2.3.4:9514

reset factory halt

Resets the GigaVUE-FM instance to the default
configuration and shuts down the system.

For example:

fmctl reset factory halt

set Ul admin password <new password>

Configures a new admin password for the GigaVUE-FM
instance.

The admin password must be a minimum of 11
characters and a maximum of 30 characters. The
characters must include at least:

e One numerical character

« One upper case character
« One lower case character
« One special character

If the password does not meet the complexity
requirements:

« The system does not display any error message.

« The parameters configured above are not passed on
to the GigaVUE-FM except the host name parameter.

« The static IP addresses that were configured originally
will be unavailable after GigaVUE-FM is deployed.

Related Commands

fmctl
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Argument Description

For example:

fmctl set Ul admin password <new
password>

{get|show} interface
[{mgmt|management}]

Displays the management interface configured for the
GigaVUE-FMinstance.

For example:

fmctl get|show interface management

set interface {mgmt|management}
<interface name>

Configures the management interface for the GigaVUE-
FM instance, which has more than one ethernet
interface.

For example:

fmctl set interface management eth1

NOTE: You cannot use the --interface syntax with the
set interface management argument.

--interface <interface name>

Allows various configurations that can be set for the
management interface. This is an optional argument.

For example, use the following command to ensure that
eth1 management interface uses DHCP:

fmctl --interface eth1 set ip dhcp

[options{--help|--interface <interface
name>}] set mapping <fqdn> <IP
address>

Maps the FQDN with the IP address of GigaVUE-FM.
For example:

fmctl --interface eth1 set mapping fm
10.10.10.1

Use the following command to remove the mapping:

fmctl --interface eth1 set mapping fm

[options{--help|--interface <interface
name>}] {get|show}
{ip|ntp|hostname|domain|fqdn}

Use to either fetch or display the IP address, NTP
configurations, host name, domain name, or FQDN .

For example:

fmctl --interface eth1 get
{ip|ntp|hostname|domain|fqdn}
fmctl --help show
{ip|ntp|hostname|domain|fqdn}

[options{--help|--interface <interface
name>}] set [ip|ip6] dhcp

Configures the management interface to use DHCP.
For example:
fmctl --interface eth1 set ip dhcp

[options{--help|--interface <interface
name>}] set [ip|ip6] [static]
<address/cidr> <gateway> <dns1>
[,<dns2>],...]

Configures the static IP address and gateway on the
management interface. You can also choose to
configure DNS.

For example:

fmctl --interface eth1 set ip static
10.115.46.72/21 10.115.40.1 10.10.1.20

Related Commands

fmctl
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Argument Description

[options{--help|--interface <interface
name>}] set {ip|ip6} route {add|remove}
address/cidr gateway

Adds or removes the IP address and gateway for the
management interface.

[options{--help|--interface <interface
name>}] set ntp {disable|[enable]
<server1>[,<server2>],...1}

Use to enable or disable NTP for synchronization of the
system's clock.

For example, the following command disables NTP:
fmctl --interface eth1 set ntp disable

You choose to enable NTP and add NTP servers. For
example, the following command enables NTP and adds
a NTP server:

fmctl --interface eth1 set ntp enable
192.168.1.10

[options{--help|--interface <interface
name>}] set hostname <hostname>

Configures the hostname.
For example:

fmctl --interface eth1 set hostname
myfm

NoTE: Ensure that you log out and re-login to the
GigaVUE-FM to view the changes.

[options{--help|--interface <interface
name>}] set domain <domain>

Configures the domain for GigaVUE-FM.
For example:

fmctl --interface eth1 set domain
gigamon.com

[options{--help|--interface <interface
name>}] set fqdn <hostname>
<domain>

Configures the Fully Qualified Domain Name (FQDN) for
the current GigaVUE-FM.

fmctl --interface eth1 set fqdn myfm
gigamon.com

[options{--help|--interface <interface
name>}] set/get/show searchdomains
[<domain1>[,<domain2>][,...]11]

Displays a list of domains for the current GigaVUE-FM
For example:
fmctl --interface eth1 set searchdomains

fmctl --help get | show searchdomains

[options{--help|--interface <interface
name>}] set/get/show nameservers
[<dns1>[,<dns2>],...]11]1

Displays a list of name servers for the current GigaVUE-
FM

For example:
fmctl --interface eth1 set nameservers

fmctl --help get | show nameservers

[options{--help|--interface <interface
name>}] show backup

Displays the configurations that were backed up.
For example:

fmctl --help show backup <absolute path
name of backup file>

Related Commands
fmctl
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Additional Sources of Information

This appendix provides additional sources of information. Refer to the following sections for details:

« Documentation

« Documentation Feedback
+ Contact Technical Support
 Contact Sales

» The Gigamon Community

Documentation

This table lists all the guides provided for GigaVUE-FM software and hardware. The first row
provides an All-Documents Zip file that contains all the guides in the set for the release.

Table 1: Documentation Set for Gigamon Products

GigaVUE-FM 5.10 Hardware and Software Guides

Hardware

how to unpack, assemble, rack-mount, connect, and initially configure ports the respective GigaVUE-FM devices;
reference information and specifications for the respective GigaVUE-FM devices

*G-TAP A Series 2 Installation Guide

GigaVUE-HC1 Hardware Installation Guide

GigaVUE-HC2 Hardware Installation Guide

GigaVUE-HC3 Hardware Installation Guide

GigaVUE TA Series Hardware Installation Guide (now including TA25)

*GigaVUE-OS Installation Guide for DELL S4112F-ON
how to install GigaVUE-OS and configure ports on COTS DELL S4112F-ON

Software Installation and Upgrade Guides

GigaVUE-FM Installation, Migration, and Upgrade Guide
how to install GigaVUE-FM on VMware ESXi, MS Hyper-V, and KVM
how to migrate GigaVUE-FM on VMware ESXi, Hardware Appliance, and AWS

GigaVUE-OS Upgrade Guide
how to upgrade the embedded GigaVUE-OS on GigaVUE H Series and GigaVUE TA Series nodes

Administration

Additional Sources of Information 96
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GigaVUE-FM 5.10 Hardware and Software Guides

GigaVUE-OS and GigaVUE-FM Administration Guide
how to administer the GigaVUE-OS and GigaVUE-FM software (note, new file name for PDF)

Fabric Management

GigaVUE-FM User’s Guide
how to install, deploy, and operate GigaVUE-FM
how to configure GigaSMART operations
includes instructions for GigaVUE-FM and GigaVUE-OS features

Cloud Configuration and Monitoring

how to configure the GigaVUE Cloud Suite components and set up traffic monitoring sessions for the respective cloud
platform

GigaVUE Cloud Suite for AnyCloud Configuration Guide
how to deploy the GigaVUE Cloud Suite solution in any cloud platform

GigaVUE Cloud Suite for AWS Configuration Guide

GigaVUE Cloud Suite for AWS Quick Start Guide
quick view of AWS deployment used in conjunction with the GigaVUE Cloud Suite for AWS Configuration Guide

GigaVUE Cloud Suite for AWS SecretRegions Configuration Guide

GigaVUE Cloud Suite for Azure Configuration Guide

GigaVUE Cloud Suite for Kubernetes Configuration Guide

GigaVUE Cloud Suite for Nutanix Configuration Guide

GigaVUE Cloud Suite for OpenStack Configuration Guide

GigaVUE Cloud Suite for VMware Configuration Guide

Gigamon Containerized Broker

Reference

GigaVUE-OS-CLI Reference Guide

library of GigaVUE-OS CLI (Command Line Interface) commands used to configure and operate GigaVUE H Series
and TA Series devices

GigaVUE-OS Cabling Quick Reference Guide
guidelines for the different types of cables used to connect Gigamon devices

GigaVUE-OS Compatibility and Interoperability Matrix
compatibility information and interoperability requirements for Gigamon devices

GigaVUE-FM REST API Reference in GigaVUE-FM User's Guide
samples uses of the GigaVUE-FM Application Program Interfaces (APIs)

Additional Sources of Information
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GigaVUE-FM 5.10 Hardware and Software Guides

Release Notes

GigaVUE-OS, GigaVUE-FM, GigaVUE-VM, G-TAP A Series, and GigaVUE Cloud Suite Release Notes
new features, resolved issues, and known issues in this release ;
important notes regarding installing and upgrading to this release

NoTE: Release Notes are not included in the online documentation.

NoTE: Registered Customers can log in to My Gigamon to download the Software and Release Notes from the
Software & Docs page on to My Gigamon. Refer to .

In-Product Help

GigaVUE-FM Online Help
how to install, deploy, and operate GigaVUE-FM.

GigaVUE-OS H-VUE Online Help
provides links the online documentation.

How to Download from My Gigamon

Registered Customers can download software and corresponding Release Notes documents from
the Software & Docs page on to My Gigamon. Use the My Gigamon Software & Docs page to

download:

« Gigamon Software installation and upgrade images,
« Release Notes for Gigamon Software, or
« Older versions of PDFs (pre-v5.7).

To download release-specific software, release notes, or older PDFs:

1. Log in to My Gigamon
2. Click on the Software & Documentation link.
3. Use the Product and Release filters to find documentation for the current release. For

example, select Product: "GigaVUE-FM" and Release: "5.6," enter "pdf" in the search box, and
then click GO to view all PDF documentation for GigaVUE-FM 5.6.xx.

NoTE: My Gigamon is available to registered customers only. Newer documentation PDFs,
with the exception of release notes, are all available through the publicly available online

documentation.

Additional Sources of Information
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Documentation Feedback

To send feedback and report issues in our documentation, complete the short survey at the
following link:

https://www.surveymonkey.com/r/gigamondocumentationfeedback

Contact Technical Support

See https://www.gigamon.com/support-and-services/contact-support for Technical Support hours
and contact information. You can also email Technical Support at support@gigamon.com.

Contact Sales

Use the following information to Gigamon channel partner or Gigamon sales representatives.
Telephone: +1.408.831.4025
Sales: inside.sales@gigamon.com

Partners: www.gigamon.com/partners.html|

Premium Support

Email Gigamon at inside.sales@gigamon.com for information on purchasing 24x7 Premium Support.
Premium Support entitles you to round-the-clock phone support with a dedicated Support Engineer
every day of the week.

The Gigamon Community

The Gigamon Community is a technical site where Gigamon users, partners, security and network
professionals and Gigamon employees come together to share knowledge and expertise, ask
questions, build their network and learn about best practices for Gigamon products.

Visit the Gigamon Community site to:
« Find knowledge base articles and documentation
« Ask and answer questions and learn best practices from other members.

« Join special-interest groups to have focused collaboration around a technology, use-case,
vertical market or beta release

« Take online learning lessons and tutorials to broaden your knowledge of Gigamon products.
« Submit and vote on feature enhancements and share product feedback. (Customers only)

» Open support tickets (Customers only)
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« Download the latest product updates and documentation (Customers only)

The Gigamon Community is a great way to get answers fast, learn from experts and collaborate
directly with other members around your areas of interest.

Register today at community.gigamon.com

Questions? Contact our Community team at community.gigamon.com
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